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I. Introduction

A. Background

This reference guide is intended to help the GPS user doing resource grade work become more
acquainted with the use of various types of GPS receivers, data collection standards, the creation of
quality GIS data and GIS tips/tricks pertaining to GPS. It is intended to be a supplement to existing help
documents and tutorials.

For many people, using GPS equipment for mapping can be an efficient way to collect accurate
information out in the field. It is often assumed that one can just pick up a unit and go collect. Since the
data exists electronically, there is a perception that it is easily transferred into the realm of GIS.
However, what many people fail to realize is just how much time is involved in converting GPS data
into a quality GIS.

GPS is one of the most accurate tools used for mapping, but it does contain some level of error. GPS
data collected with Trimble units and differentially corrected under normal conditions will yield a
confidence ranging from sub-meter to five meters in accuracy. Handheld Garmin units generally do not
have post-processing differential correction capability. However many receivers have the capability to
use DGPS and WAAS (see Section I, part C). Data collection methods play a big part in the quality of
mapped features. It is important to have the unit set correctly in order to obtain quality data. Also,
higher-end models tend to have the technology of increased filter capabilities that will provide for an
even better GPS/GIS output.

Poor data collection techniques and errors like multipath can increase the need for editing the collected
data if it is to be used in GIS correctly, preferably by the GPS user who collected it in the field. Editing
in Pathfinder Office can minimize unnecessary work in the GIS.

There are a number of programs available to the user for converting GPS data into GIS. When working
with Trimble units, Pathfinder Office is usually used. There are several utilities available for
downloading Garmin data into GIS, some of which are covered here. GPS data can readily be exported
into various GIS formats, but for the general user, the typical format is the Arcview shapefile. Master
datasets that may reside in a GIS library on a network are generally stored as Geodatabases or ArcInfo
coverages. GPS coordinates stored in a textfile format can also be brought into GIS using ArcMap or
ArcCatalog. It is possible to convert data without realizing that the wrong configuration settings were
used. Hopefully by adhering to the following procedures, many mistakes can be avoided.

Disclaimer: This document is maintained approximately once a year. While all effort is made to keep
information as up-to-date and accurate as possible, this document is not guaranteed to be free from
errors. Due to constant changes in technology in regards to GPS units and PC software, some models
may not be discussed. The program versions for the following software titles referenced in this manual
are as follows:

Pathfinder Office 3.1 ActiveSync 4.1 Corpscon 5.11.08
DNR Garmin 5.1.2 ArcGIS 9.0 Waypoint+ 1.8.03
Windows 2000 ArcPad 6.0.3 GPS Utility 4.10.0
GPScorrect 1.01 TerraSync 2.52 GPSAnalyst 1.20

GPS Photo-Link 3.5.0
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Starting with GPS to GIS version 7.0, all documentation pertaining to ArcView 3.x has been removed as
the Forest Service is discontinuing use of ArcView 3.x. Refer to previous versions of the GPS to GIS
document for information pertaining to ArcView 3.x.

B. Coordinate Systems

The following are excerpts taken from the online help in ESRI’s ArcMap discussing coordinate systems
and datums.

Coordinate Systems:

“The features on a map reference the actual locations of the objects they represent in the real world. The positions of objects
on the earth's spherical surface are measured in geographic coordinates. While latitude and longitude can locate exact
positions on the surface of the earth, they are not uniform units of measure; only along the equator does the distance
represented by one degree of longitude approximate the distance represented by one degree of latitude. To overcome
measurement difficulties, data is often transformed from three-dimensional geographic coordinates to two-dimensional
projected coordinates.

A geographic coordinate system (GCS) uses a three-dimensional spherical surface to define locations on the earth. A GCS is
often incorrectly called a datum, but a datum is only one part of a GCS. A GCS includes an angular unit of measure, a prime
meridian, and a datum (based on a spheroid).”

Datums:

“While a spheroid approximates the shape of the earth, a datum defines the position of the spheroid relative to the center of
the earth. A datum provides a frame of reference for measuring locations on the surface of the earth. It defines the origin and
orientation of latitude and longitude lines. Whenever you change the datum, or more correctly, the geographic coordinate
system, the coordinate values of your data will change.”

Geographic (or datum) Transformations:

“Because the geographic coordinate systems contain datums that are based on spheroids, a geographic transformation also
changes the underlying spheroid. There are several methods, which have different levels of accuracy and ranges, for
transforming between datums. The accuracy of a particular transformation can range from centimeters to meters depending
on the method and the quality and number of control points available to define the transformation parameters. These include
the Geocentric Translation, Molodensky, and Coordinate Frame methods. See Equation-based methods for more information.
Other methods such as NADCON and NTv2 use a grid of differences and convert the longitude—latitude values directly. See
Grid-based methods for more information.”

NADCON:

“The United States uses a grid-based method to convert between geographic coordinate systems. Grid-based methods allow
you to model the differences between the systems and are potentially the most accurate method. The area of interest is
divided into cells. The National Geodetic Survey (NGS) publishes grids to convert between NAD 1927 and other older
geographic coordinate systems and NAD 1983.”

Throughout this document, there are references to various coordinate systems, projections and datums.
The term “projection” is often used interchangably with “coordinate system.” While this is not entirely
accurate, this document will use both of these terms. Additional definitions of terms used when
discussing projections can be found at the following addresses:

http://biology.usgs.gov/geotech/documents/datum.html
http://www.vterrain.org/Projections/




ESRI’s website, ArcMap online help and user manuals are also excellent source material for learning
about map projections, coordinate systems and datums.

The Forest Service in Region 2 currently maintains its GIS data in a projected coordinate system.

projection:  UTM datum: NADS83 Conus
zone: 13N units: meters

Since the GIS data resides in the NAD83 datum (GCS_North American_1983), this implies the need to
reproject GPS data from and to WGS84 (GCS_WGS_1984). Originally, NAD83 and WGS84 started out
pretty much the same, but over the years, both datums have been refined. There is now a difference of a
little more than one (1) meter between these two datums. Procedures for the various “Scenarios” are
outlined in the Trimble Support Note: GPS Pathfinder Office Software or the GPS Analyst Extension for

ESRI ArcGIS Software: Resolving the NAD 83 Datum Transformation Issue.
http://trl.trimble.com/docushare/dsweb/Get/Document-170369/SprtNote PFO-GPSA NADS83Datum.pdf

This one-meter difference is only critical to those desiring sub-meter accuracies. Ideally, the user should
try to use the proper datum transformation for the situation, but it may be in the best interest of the
project to assume WGS84 is equal to NADS3 for simplicity if dealing with multiple users.

For those who use NAD27... set the datum to NADCON in GPS applications using NAD27 coordinates
when possible. Not using this method for NAD27 data can result in several meters of error. NOTE:
There are WGS84/NAD27 transformation issues within ArcPad and ArcMap (see Appendix J).

This document does not discuss all the complexities involving projections and datums. Instead, it
simply outlines what projection and datum need to be used depending on the data situation. The
following table mainly pertains to Forest Service’s use of data in the NAD83 datum in Region 2.

USGS Topo Geographic (Lat/Long) NAD83 quad tics can usually be found offset from the NAD27 tics.
Currently, USGS topos do not have NAD83 UTM tics.

GIS data for Region 2, GIS data resides in UTM, NADS83 Conus, Zone 13 N, meters

GPS receivers when collecting data, most GPS receivers store positions in Geographic (Lat/Long) WGS84

Waypoints when creating waypoints, one must keep in mind what projection/datum the source coordinates are

in, especially when entering the coordinates by hand. Geographic WGS84/NADS3 coordinates are
different from Geographic NAD27 coordinates.

GPS Analyst/ArcPad The correct datum transformation will need to be used based on the situation to correctly move
between WGS84 and NADS3 to remove the 1 meter difference between the datums.

The user should try to have a basic knowledge of these differences in projection values in order to
correctly select the projection that meets their needs. Any user that has a question or concern regarding
projections and GPS should contact the local GIS specialist.

Tech Tip: 1.1 Know what you are working with. Ask!
“What is the coordinate system? What is the datum?”

C. GPS Receivers

There are a variety of GPS receivers available on the forest and it is important to understand their
capabilities and limitations. Keep your data needs (including type of data) in mind when selecting a unit.
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Data quality can vary within a GIS. It is also important to understand who will edit and/or use this data.
Make an effort to obtain the best data possible. Trimble units are specifically designed to collect and
store spatial information. Garmin units are primarily designed as a navigation tools.

The San Juan GIS Team recommends the use of Trimble (or equivalent) GPS units for data
collection when units are available. These units interface with GIS very well and provide quality
controls that can typically yield a higher quality of data than off-the-shelf models. However, it is
understood that cost, availability and need can be limiting factors and several less expensive Garmin
handheld units are available to users on the forest. Users should be aware of the issues bringing data
into GIS from a Garmin unit, much of which is addressed in this document. Receivers that interface with
Pocket PC’s are also a valuable tool and contain quality controls through ArcPad. Any GPS data going
into GIS layers, regardless of source, should be checked for quality.

GPS accuracy and data standards can vary between forests and agencies as well as be influenced by the
type of data being collected. Some national direction has been set for certain kinds of information. The
following is a brief list of some defined standards and accuracy requirements.

GPS Standards defined e NMAS 40ft (12.2m)
e  GPS standard for GIS (draft) WO e NSSDA 13.9m
e FGDC part 3 Geospatial e FGDC 10m
Positioning Accuracy e GPS design accuracy < 15m
e FSH 2409.12 Timber cruise e T AAS, WAAS for
Handbook airport/aircraft requires 5

satellites.

Various Accuracy Requirements

NMAS Standards 90% Accuracy
Map Scale 1:x | Feet +/- | Meters +/- Map Scale 1:x | Feet +/- | Meters +/-
100 0.3 0.08 12000 33 10.06
500 14 0.42 20000 55 16.76
1000 2.8 0.84 24000 40 12.19
2000 6 1.68 63360 106 32.19
5000 14 4.19 100000 167 50.80
10000 28 8.38 250000 417 127.00

Source: NPS Alaska Support Office

Comparisons between various receivers

Mobile device comparisons by the SDTDC -- http://fsweb.sdtdc.wo.fs.fed.us/programs/im/fy03/ppc/ppe.shtml
GPS Receiver tests by the USES -- http://www.fs.fed.us/database/gps/gpsusfs.htm

GPS receiver comparisons -- http://fsweb.santafe.r3.fs.fed.us/gis/documents/GPS/Comparison_GpsAccuracyStd_1 21 04.xls
GPS tests under canopy -- http://fsweb.santafe.r3.fs.fed.us/gis/documents/GPS/Compare_GPS_Receivers SA_off RMS.doc
Recreation grade VS. resource grade -- http://www.esri.com/news/arcuser/0104/rec-gps.html

Garmin products -- http://www.garmin.com/outdoor/compare.jsp

Trimble products -- http://www.trimble.com/mgis_prodcomp.shtml




General Features

1. Trimble: 8-12 channel (including GeoXT, XM, XH, GeoExplorer 1,2,3, ProXL, ProXR
Pathfinder Pocket)

Cost: $-$$$
Accuracy:
a. Uncorrected data without Selective Availability: 5-15 meters
b. Differential Correction (DGPS): subfoot-5 meters
c. Wide Area Augmentation System (WAAS) capable receivers: < 7 meters.
Refer to the FAA’s website for a detailed description of WAAS.
http://gps.taa.gov/FAQ/index.htm
d. Carrier Phase: Subfoot
Features:
a. Data Dictionary — to record attributes in greater detail. Can be designed to
match existing GIS layer attribute fields.
Postprocessing — GPS files can be differentially corrected and edited.
Can average multiple positions per point or vertex to increase accuracy.
Memory storage — generally can accommodate large amounts of data.
Ideal for Point, Line and Polygon data.
Can utilize background images (like orthophoto quads) in CE models.
Software Pathfinder Office, TerraSync and GPScorrect for ArcPad

RN

2. Garmin: 8-12 channel

Cost: $
Accuracy:
a. Uncorrected data without Selective Availability: 15 meters
b. Garmin under trees 20-40m.
c. Real-time DGPS (must have beacon receiver, antenna and within range of a
beacon transmitter): 3-5 meters
d. Wide Area Augmentation System (WAAS) capable receivers: < 7 meters.
Refer to the FAA’s website for a detailed description of WAAS.
http://gps.faa.gov/FAQ/index.htm

Features:
a. Designed and excellent for navigation.
b. Works well for collecting points.
c. Small, lightweight.
Software: Several extensions available for downloading to Arcview and ArcMap.
Line or Polygon data will require a lot of editing.

3. GPS receivers for Pocket PC’s: 12 Channel

Cost: $
Accuracy:
a. Uncorrected data without Selective Availability: 5-15 meters
b. Differential Correction (DGPS): None
9



c. Wide Area Augmentation System (WAAS) capable receivers: <7 meters.
Refer to the FAA’s website for a detailed description of WAAS.
http://gps.faa.gov/FAQ/index.htm

d. Interface with ArcPad allows for quality control.

Features:

a. Designed to work with the iPAQ or Dell Pocket PC.

b. Works with ArcPad allowing the creation of shapefiles from GPS data.

c. Small, lightweight.
Software: ArcPad

D. Waypoints

Many times, it is useful to upload GIS data to a GPS unit for use in the field, whether for updating
information or for simple navigation. It is important to understand a little about projections (see

Section I, part B) when preparing data for navigation back out in the field.

When entering waypoints manually, set the GPS/GIS projection to match the projection of the source
coordinates of the point to enter. For example, if entering a Lat/Long NAD27 coordinate in Pathfinder
Office that originated from GIS or a Topo, you would set the Pathfinder coordinate system to Lat/Long
NADCON. If entering a Lat/LLong NADS83 coordinate that originated from the GPS unit that was set to
Lat/Long NAD8&3 Conus, you would set the Pathfinder coordinate system to Lat/Long NAD83 Conus.
You can create and upload Waypoint files to a Trimble GPS unit using Pathfinder Office.

Garmin GPS12 UTM points appear to be rounded to whole numbers and tenths for Lat/Long. A point in
UTM NAD&3 does not necessarily match the same UTM NADS3 point entered on a Trimble. There is at
least couple meters difference. Also, be aware of the difference between Geographic WGS84, NADS3

and NAD?27 coordinate values.
E. Preplanning

Preplanning software like Quick Plan or
Trimble Planning Software enables the user to
make efficient use of field time by identifying
the optimum times to collect GPS based on
certain conditions like PDOP and elevation. The
program uses an Almanac that contains orbit
information for every GPS satellite. Almanacs
can be obtained from the GPS unit or the
internet. Quick Plan comes with Pathfinder
Office. Trimble Planning Software can be
downloaded free from the following address.

http://www.trimble.com/planningsoftware_ts.asp?Nav=Collection-8425
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F. Fire (Incident) Application

More and more, the firefighting community is using GPS as a tool for mapping and navigation. The wide
variety of basic GPS receivers, relatively low expense and interface with GIS applications has increased
the need for GIS specialists (and average users) to become more familiar with this type of data
management and manipulation. Garmin receivers are probably the most common units found on an
incident.

Unlike GIS specialists who normally work in projected coordinates (UTM, State Plane), the fire
community typically operates in Geographic (Latitude/Longitude) coordinate space. For standard
communication purposes, the fire community (at least in Region 2) is supposed to provide coordinates in:
Latitude/Longitude
Degrees, Minutes, Decimal Seconds (DD° MM’ SS.ss”)

However, for communication with aircraft, the format is typically:
Latitude/Longitude
Degrees, Decimal Minutes (DD° MM.mm”)

These standards do not stipulate a datum. A GIS specialist is often asked to plot these coordinates on a
map. For this reason the GIS user should always ask the person providing the coordinates:

“What is the coordinate system? What is the datum?”

This only applies to verbal or hand-written coordinates. If data was physically collected within the GPS
unit, it usually exists as Geographic WGS84 data until it is downloaded into GIS.

G. Sources of GPS Error

Typical Error In Meters
(per satellite) Uncorrected | Corrected
Satellite clock errors 1.5 0 Satellite clocks 1.5-3.6
Orbit errors 25 0 Orbit errors 25
lonospheric delay 5 0.4 lonosphere 50-7.0
Tropospheric delay 0.5 0.2 Troposphere 05-0.7
Receiver noise 0.3 0.3 Receiver Noise 03-15
Multi-path errors 0.6 0.6 Multipathing 0.6 or more
Total 10.4 1.5 Source: NPS Alaska Support Office

Source: Carl Beyerhelm, Coconino NF

H. Files Extensions

The are a number of different files associated with GPS and GIS. Questions about a particular file may be
able to be answered at the following sites.

e File extensions associeated with GPS and GIS -- http:/fsweb.sanjuan.r2.fs.fed.us/gis/file_extensions.doc

e Search for any file extesion -- http:/filext.com/
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II. Trimble Receivers

A. Comparison of GeoExplorer CE Models
Part numbers in bold occur on the San Juan NF.
NOTE: Accessories (like the serial clip) are not interchangeable between the pre-2005 and 2005 series.

@-Trimble

GeoExplorer 2005 series
Part Numbers
60950-00 (XH)
60950-20 (XT)
60950-50 (XM)

USB hub not recommended for support module
connection to PC to avoid communication
problems.

Operating System is Windows Mobile 2005
(version 5 or greater).

Bluetooth capable

2005 series support module.

2005 series serial clip.

TFT (Thin Film Transistor) screen

64MB RAM

512MB on board Flash disk space.

SD memory expansion card slot.

GeoExplorer 2001 series (discontinued)

g Trimble

Part Numbers
46475-00, 46475-10 (XT) 128 MB

46475-50 (XM) 512 MB

damage.
e  Operating System is either
No Bluetooth capability.

pre-2005 series serial clip.
Non-TFT screen

32MB RAM
128MB or 512MB Flash disk space.
No expansion memory slot.

pre-2005 series support module.

12

GeoExplorer 2003 series (discontinued)

[ @ Trimbie

Part Numbers
CE.NET
49050-20 (XT)
49050-30 (XT)
49050-50 (XM)
49050-60 (XT)
49050-70 (XT)
49050-75 (XT)
Windows Mobile
50950-20 (XT)
50950-50 (XM)
49050-70 (XT)
49050-75 (XT)

USB hub required for support module connection
to PC with USB 2.0 to prevent computer damage.
Operating System is either
o Windows CE.NET (version 2.00.02)
o Windows Mobile 2003 (version 3.00.01)
Bluetooth capable.
pre-2005 series support module.
pre-2005 series serial clip.
TFT (Thin Film Transistor) screen
64MB RAM main memory.
512MB on board Flash disk space.
No expansion memory slot.

46475-20, 46475-30, 46475-60, 46475-70, 46475-75 (XT) 512 MB

e USB hub required for support module connection to PC with USB 2.0 to prevent computer

o  Windows CE 3.0 (version 1.10.02 or earlier)
o  Windows CE.NET (version 2.00.02)



B. GeoExplorer CE Series

Three methods of communication between the datalogger and the PC exist: the support module
(cradle), wireless bluetooth and the optional serial clip. The primary method is through the use of the
support module which utilizes a USB cable. The serial clip uses a 9-pin null modem cable that plugs
into a serial (COM) port. The communication options in the CE unit are governed by the method used.
Initial setup will require Administrative privileges for a Windows 2000 PC.

Power Basics

There are three power states, ON, SUSPEND and OFF.
Pressing the power button once toggles the unit between ON and SUSPEND modes.
Pressing the power button and holding it for 15 seconds turns the unit OFF. It is recommended

that the unit be turned off when not in use for several weeks.
NOTE: This is also how to perform a Hard Reset.

Getting Started Guides

It is recommended the user consult the Getting Started Guides pertaining to the GPS unit. Guides for
certain units are listed below.

GeoExplorer with Windows Mobile for Pocket PC 2003 and 2005 —
http://trl.trimble.com/docushare/dsweb/Get/Document-170309/Geo_300_GSG_46506-30-ENG.pdf
GeoExplorer with CE.NET —
http://trl.trimble.com/dscgi/ds.py/Get/File-145871/GeoCE_200_GSG_46506-20-ENG.pdf

GeoXT Quick Start Guide — Carl Beyerhelm, Coconino NF
http://fsweb.santafe.r3.fs.fed.us/gis/documents/GPS/GeoXT_QuickStart.doc

GPS Controller

This free program can be installed (if not already) that provides access to GPS access and setup
options. It is similar to the Status screen in Terrasync and GPScorrect. It position filters and real-
time correction settings can be used within ArcPad by using the NMEA setting.

1. Communication with the PC

Refer to the Getting Started Guides for detailed instructions on connecting to the computer. Some
key items specific to the units are listed below.

a. ActiveSync

Prior to any software installation on the unit, Microsoft’s ActiveSync program must be
installed on the PC. This program enables the PC to communicate with the GeoCE series (or
other mobile unit). Administrative privileges are required to install ActiveSync on a Windows
2000 computer. This program can be downloaded from Microsoft’s website for free. Once
installed, the datalogger can now be connected to the PC.

Setup ActiveSync
1. On the PC, select Start > Program Files 2 Microsoft ActiveSync.
2. Depending on the connection used (USB or COM), you may need to adjust the connection
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settings in ActiveSync. Select View = Connection Settings. This will show the types of
connections ActiveSync can look for and use.

3. As a default, all the options available are selected. It may be helpful to only select the
communication option (USB or COM) that the CE unit is using. This is especially
important where multiple mobile units or dataloggers are connected to the same PC.
ActiveSync can create conflicts when the user is trying to access other devices.

4. Minimize ActiveSync by single-clicking on the staple in the upper right-hand corner. This
will put a gray ArctiveSync icon in the Taskbar in the lower right-hand corner of Windows.
ActiveSync must be open prior to connecting to the CE unit.

b. Support Module

1. IF this is the first time the cradle and USB cable have been used on a Windows 2000 PC,
it will require Administrative privileges to install the USB driver.

2. Connect the support module to the PC by plugging the USB cable into the port. The PC
will find and install the new hardware.

3.

c. Serial Clip

1. If using the Serial Clip, the connection type is typically ‘COM 115200°. Only those units
using CE.NET will need to have the connection set manually. Pocket PC will auto-detect
the serial clip.

2. For Dell Laptops (USFES), the connection type for the Serial Clip may need to be set to
‘COM 57600°.

3. On a unit running Windows Mobile 2005, changes to connection options are located in
Activesync - Menu - Connections

4. On a unit running Windows Mobile 2003, changes to connection options are located in
Activesync - Tools - Options = Options

5. On a unit running CE.NET, changes to connection options are located in
Start - Settings - Control Panel > Communications - PC Connection

NOTE: When switching between various methods of connection, DO NOT forget to change
the communication settings in the unit. Otherwise the datalogger will be unable to talk to
the PC. Also, there is more than one COM speed available to communicate to the PC if
needed.

Tech Tips: Communications Troubleshooting -- Some users have experienced connection problems
between the CE unit and the PC using ActiveSync. The following is a list of suggestions users can try to
obtain a connection. The user manual, online help or the web may also offer suggestions.

#2.1 Users unable to connect a 2005 series CE unit and the PC using ActiveSync may need to install a
USB switch to resolve the problem. Use the USB Switch Application to Resolve Microsoft

ActiveSync Connection Difficulties
http://trl.trimble.com/docushare/dsweb/Get/Document-283726/MGIS _SprtNote Geo2005 ActiveSync_ USBSwitch.pdf

#2.2 When using the support module USB connection for the first time in a profile other than the
profile the USB was installed under, the PC may “attempt” a reinstall of the USB. If no
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administrative privileges are present, a message stating such will be displayed. If connecting
with ActiveSync, the mobile unit will generally make a connection anyway as it had been
installed and used previously. Ignore the error message and click OK.

#2.3 Communication will only be established when initiating the connection from the CE unit. This
can be done by either inserting the unit into the cradle and having it automatically attempt
connection or by manually initiate it with Connect to Desktop. Don’t try connecting using the PC.

#2.4 Check the Connection Settings in the CE unit to make sure the correct method (USB or COM) is
being used.

#2.5 Install the latest version of ActiveSync. The GeoExplorer 2005 series requires version 4.1 or
greater.

#2.6 Perform a Hard Reset on the CE unit.

#2.7 There may be an conflict if multiple mobile units are connected to one machine and/or using
ActiveSync or another synchronization program. It may be necessary to physically disconnect
the additional mobile units during the time the GPS unit is connected.

#2.8 & _ Available for connection & _ CE device connected to PC . Connection disabled
2. Operating System and Installation of Software

With the advent of handheld PC technology, several varieties of Windows CE Operating

Systems (OS) are available for various handhelds. Several OS versions may be installed on a CE
device, Windows CE 3.x, Windows CE.NET, Windows Mobile for Pocket PC 2003 and Windows
Mobile for Pocket PC 2005. These operating systems are similar to the relationship between
Windows NT, 2000 and XP. These are similar, yet separate systems and vary on what programs
they can support. Windows for Pocket PC (which iPAQ and Dell operate) comes with Pocket
Excel and Pocket Word. Windows CE lacks these programs, but supports Terrasync. Both systems
can support ArcPad. Refer to Appendix D for a comparison of Windows CE Operating Systems.

Trimble has redesigned their GPS dataloggers to operate in the Windows CE environment. This
not only allows the unit to operate in a GPS capacity, but also allows the flexibility of a handheld
PC in accommodating other programs, like the GIS oriented ArcPad. This environment requires
the user to install software on the datalogger, just like a normal PC. Some software titles are
dependent on the type of OS installed.

Refer to the following document if you need help determining what version of CE operating
system is on the unit. http://fsweb.sanjuan.r2.fs.fed.us/gis/GPS/determining_OS_versions.pdf

Software installation onto the CE unit will require Administrative privileges for a Windows 2000
PC. Many titles come with an installation key in order to install the software, as well as apply
any updates. Some are also requiring online registration of the software in order to acquire the
access code for installation.

a. The Soft Reset

New program installation or OS problems may require a Soft Reset to be performed. This
stops all running programs, but maintains files in the RAM.
1. Press the power button and hold down for about 5 seconds.
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2. The unit will perform a reboot. The phrase Soft Reset will be visible on the screen.
b. The Hard Reset

Should problems persist (the unit become unresponsive or stop functioning correctly), it may
be necessary to perform a Hard Reset on the CE unit. Files in RAM are erased and the OS is
reloaded. To initiate the reset:
1. Press the power button and hold down for about 15-20 seconds.
2. The unit will reboot (as in Soft Reset), but keep holding the power button until the unit
turns off.
3. Press the power button again to turn the unit on. The unit will reboot and OS install
from the last backup.
NOTE: Never hold the power button for 60 seconds.

Tech Tip #2.9 The CE unit contains two sections of internal storage space, Main Memory and Disk.
On installation of most software, it is recommended that the software be installed in the
Disk portion of the CE unit. The reason is that the Disk portion can be backed up.
Should the unit stop functioning normally and need to be reset, the OS (including
installed programs and data) will be restored from the last backup. On a hard reset, the
Main Memory is cleared and anything stored in there is lost.

#2.10 If the GeoCE unit will not power up and/or the screen has nothing but a white
background displayed, the unit will need to have a Hard Reset performed on it.

#2.11 There are two separate My Documents directories located on the GeoCE unit. One
exists in Main Memory and the other in Disk. TerraSync GPS data should be stored in
Disk/My Documents/TerraSync. Any other data (like ArcPad shapefiles) can go in a
separate folder under Disk/My Documents.

3. TerraSync - Setup and Operation

This document will focus on the primary functions of the TerraSync program. For more detailed
information, consult the online help or the user manual. If using the GeoCE unit with ArcPad,
refer to Section VII. There are five main sections (or screens) within TerraSync.

a. Setup

Setup is where the GPS system settings are managed. This includes coordinate system and
accuracy controls Position Dilution of Precision (PDOP), Horizontal Dilution of Precision
(HDOP), Signal-to-Noise Ratio (SNR) and Carrier-to-Noise Ratio (C/No). HDOP can be used
in lieu of PDOP if vertical accuracy is not critical.

Options -- Connecting or disconnecting to the GPS receiver or external accessories.
Logging Settings -- Logging parameters for a GPS file. Feature settings can also be
modified in here if a file is open (active). NOTE: Most features should b
collected at either a 1 second or a 5 second logging interval.
GPS Settings -- Critical settings for data collection, includes PDOP, SNR (or C/No) and
Elevation masks. Settings may need to be adjusted in situations where satellite
acquisition is difficult, but this will affect accuracy. For Region 2, the default
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C.

settings are recommended:
Max PDOP = 6 or HDOP =4
Min SNR =4 or C/No = 39 (Terrasync 2.5 or later)
Min Elevation = 15 degrees
Real-time Settings -- Set if desiring to receive some form of Real-Time correction (i.e.
WAADS).
Coordinate System -- A wide variety of coordinate systems and datums are available for
use. The user should set this in accordance to the needs of the
project. This affects display only. Generally, the NAD83 Conus datum will
be used with either UTM or Lat/Long. However, current versions of Trimble
software include the NAD83 (CORS96) datum as an option.
Units -- Various units of measure, including the type of Lat/Long format. Affects display

only.
External Sensors -- Settings for external equipment.

Status

This view shows the current status of the GPS operations and environment. Logging settings
can also be modified within this view.

Skyplot -- The current configuration of satellites visible to the datalogger. PDOP and current

location are visible in this view.

Satellite Info -- Status of individual satellites.

Receiver -- Receiver information.

Real-time -- Information on Real-time if it is enabled.

Plan -- Once an Almanac has been loaded, this enables the user to view the projected PDOP

and satellites available up to a 12 hour period based on the current location.
An Almanac is downloaded from the satellites automatically.

Sensor -- Information on any attached sensors.

Comms -- Status of the COM ports.

UTC time -- The current Universal Time Coordinated (UTC) time. Also known as
Greenwich Mean Time (GMT) or Zulu time. The San Juan NF is six hours (-6)
behind UTC during Mountain Daylight Savings and seven hours (-7) during
Mountain Standard time.

About -- Version information about TerraSync.

Data

This is the data management view where files are created, manipulated or deleted. This view
also contains the Data Dictionary Editor where all dictionaries (except Trimble’s Generic
dictionary) can be modified.

New File -- The creation of a new Rover file.
Collect features -- This is for collecting new features.
Update features -- This is for updating existing features.
Options -- Options in how features are collected.
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Logging interval -- Another place to set the logging interval for the features
within the data dictionary being used.
Log Now/Later -- Choose whether feature logging begins immediately or on
pause (easier for entering attributes).
Repeat -- The next feature created will have the attributes of the previous feature.
Segment line -- Creates a new line that is connected to the previous line.
Continue -- Continues the collection of a line that was, for example, interrupted
by the collection of a point.
New Vertex — Used to collect multiple positions (averaging) at a point along a
line or polygon for a more accurate feature representation.
Close -- Closes the feature.
Create -- Creates a new feature for collection.
Existing File -- Opens an existing file.
File Manager - Copy, Delete, Rename, etc. the various file types supported by TerraSync.
The Data Dictionary Editor is also found here allowing the data dictionaries
available in the unit to be modified. New dictionaries can be created here.

. Map

This view is a mini-GIS environment. The view allows the user to see their location in
relation to other features. Some on-screen digitizing is available. Background layers can be
used as well as the setting of navigational targets.

Tools (icons) -- Select, Zoom, Pan, Digitize, Measure. Very basic GIS type tools for use
within the Map view.
Options -- Various operations that can be performed within the Map view.

NavTargets -- Setting and clearing of targets for navigation. This can also be performed
in the Data view.

Enter Coordinates -- Allows the manual entering of coordinates of a point feature. Refer

to Waypoints and Navigation for this process.
Layers -- Options to adjust various map display features.

Background File -- Allows the user to load one (1) background file at a time for display.
This file can be another GPS file or an image (like a digital orthoquad). The
coordinate system on the unit must match the image’s coordinate system or
the image will not be displayed. TerraSync 2.4 or later supports MrSID,
JPEG, TIFF images. The San Juan NF has digital topographic and
orthoquads in MrSID format, GeoTIF maps can be created in ArcMap (see
Section IX, part 5). NOTE: All background files must be loaded into the
Disk/My Documents/TerraSync portion of the CE unit by the use of the
Data Transfer program in Pathfinder Office. The images .CS file will not be
created (required by TerraSync) if the Data Transfer program is not used.

GPS Trail -- A trail of the last 60 positions calculated (not collected) by the receiver.

Layer Formatting -- Layer color can be set here.
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e. Navigation

This view displays navigational information to the user like time, distance, bearing, etc. from
their intended target. Navigational targets are set in either the Data or Map views.

Options -- Settings for the display of navigation features.

Heading Options -- There are four heading options (out of a possible 12) displaying
the status of the user’s approach to the navigational target. A turn arrow
will show the direction of the target in relation to the direction of travel.

4. Waypoints and Navigation

There are no longer Waypoints, as such, in the TerraSync environment. Trimble has eliminated
Waypoints as a GPS feature. This means that the creation of features for navigational purposes,
whether GPS’d or manually entered, are now done within a standard Rover file. Any waypoint
files generated in Pathfinder Office and transferred to the CE unit are converted into Rover files.
GIS data can also be imported (see Section III, part E.)

a. Manually Entering a Coordinate in TerraSync

1. In the Data view, create a new file or open an existing one.

2. IF the receiver is connected, select Options 2 Log Later. If disconnected,
go to step 3.

3. Switch to the Map view and select the Digitize mode by clicking the drop-down next
to the black selection arrow.

4. If the receiver is not connected, load a background file by selecting Layer -
Background File and select one from the list. (One must already by loaded onto the
Disk.) This will help setup coordinate space. Remember, the projection display in the
CE unit and the image must match.

5. Click the Create Feature button (® blue dot) and select a point feature to create
(providing a point feature is available in the data dictionary being used.) This will
switch back to the Data view with the feature ready for data entry.

6. Enter the attributes desired using the digital keyboard. DO NOT click OK, but switch
back to the Map view.

7. Select Options > Enter Coordinates.

. Enter the desired coordinates and click OK.
9. Click the Stop button (M red square). This will commit and store the feature in the
Rover file.

o0

C. GeoExplorer 3/3c
1. Communication with the PC

There methods of communication between the datalogger and the PC through the use of the
support module or the optional serial clip. Both use the 9-pin null modem cable.

a. Support Module setup
1. Connect the support module to the PC.
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2. Place the datalogger into the cradle.

3. On the datalogger, select SYS (button) = Setup (tab) 2 Configurations - Data
Transfer: Support Module.

b. Serial Clip setup
1. Attach the serial clip to the datalogger
2. Using a 9-pin null modem cable, connect the datalogger to the PC.

3. On the datalogger, select SYS (button) = Setup (tab) 2 Configurations - Data
Transfer: Serial Clip.

NOTE: When switching between various methods of connection, DO NOT forget to change the
communication settings in the unit. Otherwise the datalogger will be unable to talk to the PC.

Refer to Section III, part A for downloading data.

. Asset Surveyor -- Setup and Operation
Dan Greene — 10/19/2001, modified by Mark Roper 5/30/2002

a. Buttons
Power (Black) button — Power on/off or Check Power and Memory (SYS key)
SYS - check for satellites, power, setup, coordinate system for navigation, etc
DATA - enter point, line or polygon data
LOG - pause or start logging data
NAYV - navigate to a known location
CLOSE - close a menu
OPTION - options off of sys, data or nav
FN with OPTION = more options
ARROWS - up, down, right, left for menus

b. Coordinate System for GPS Unit

The user should select a coordinate system they are most comfortable with for display
purposes. If there are several units assigned to a particular project/resource unit, then all should
be set to the same coordinate system. This should be decided by the project or resource unit
leader. It does not matter what coordinate system is set on the GPS as it always stores data in
Geographic (Lat/Long) WGS84. The user will convert the data into a desired projection using
the export function in Pathfinder Office.

NOTE: The coordinate system can make a difference when entering waypoints or referencing
a map. The user needs to keep in mind the coordinate’s source when manually entering a
point.

Coordinate System: LAT/LONG

Datum: NADS3 Conus
Altitude Reference: MSL
Altitude Units: FEET
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c. Satellites

SYS key — tracking for GPS when solid black fill. This is dependant on the GPS setting of
PDOP and SNR best set with the bar graph. The higher the PDOP number the worse the
spatial accuracy. When changing settings on the bar, you can see that PDOP and SNR are
related and both change. Region 2 standards recommend a PDOP of 6 or less, but that is not
always possible. If this accuracy is not obtainable, any adjustment should be documented. The
message on the screen will let you know if there are not enough satellites based on your
settings. Preplanning is a good way to determine when the optimum time to collect will occur
based on specified settings.

d. SYS Function Key

FN OPTION for main menu (setup, config)

DATA

Log between features -- OFF

Log PPRT data -- NO

Log velocities -- NO

Antenna height -- 1 meter or 3.28 feet (about waist high)

Allow GPS update -- NO

Warning distance -- N/A

Filename prefix -- R (default is R but you could set to your initials)

UNITS
Set the Units to what is practical for finding your way around on the ground.
These are not related to what you will export for GIS.

Distance -- Feet

Area -- Acres

Velocity -- Feet/Second

Angle -- Degrees

North Reference -- True

Declination -- Auto (the unit figures it out)

GPS
PDOP Mask -- 6.0 using the custom settings. However if you can’t get
satellites you may need to use a higher number.
SNR Mask -- 4.0 using the custom setting. This dictates that a satellite’s signal
will not be used if less than 4.0.
Elev Mask -- 15 degrees (default setting)
Min Satellites -- 4
NOTE: Remember, changing these values affects accuracy and data quality.
COORDINATES

See above recommendation for Latitude/Longitude
Refer to the Export Settings for UTM recommendations.
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FORMAT
Language -- English
Offset -- Horz/Verticle
Degrees -- DD MM SS
Time -- 24 hr
Time Zone (-7 without daylight savings, -6 daylight savings)
7 hours less than Greenwich time
Coordinate Order -- Lat/Long

e. DATA Function Key
This is for entering new data. Before entering data check to see if you have enough satellites.

Files are used to store data sets. A set of GPS data is a collection of lines, points and polygons
(areas). You may use the LOG key to switch between points or different features. As an
alternative, you may use different files for different feature types.

Delete Files (All files are retained unless you specifically delete them)
Option, Delete Files

Create New File
Point
Line
Area

The point, line and area are default types. If you use the data dictionary (preferably using
Pathfinder Office, then you can establish your own feature types that also have data collection
fields. This is very easy to do and when done you can easily upload the files from the PC to the
hand held unit. See the video on CD for an excellent tutorial on how to do this. Data
dictionaries should be set up before going to the field.

3. Waypoints and Navigation

The GeoExplorer 3 and 3c differ in the fact that the 3¢ cannot upload data files for navigation. It
can only use waypoint files. Refer to Section III, part E on importing data for navigation.

II1. Pathfinder Office
A. Data Transfer

Data Transfer of Trimble GPS files can be accomplished by running the Data Transfer program.
1. GeoExplorer CE series

a. Start ActiveSync on the PC if it is not already running. Start > Program Files >
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Microsoft ActiveSync.
b. Connect datalogger to ActiveSync.
c. In Pathfinder Office, select Utilities = Data Transfer.
d. The program will try to automatically connect with the unit. It may be necessary to
select the correct datalogger option, GPSdatalogger on Windows CE.
e. On the Receive tab, click Add = Data File (for GPS Rover files).
f. Highlight the desired files and click Open.
g. Click Transfer All.

2. GeoExplorer 3/3c

Data transfer of Trimble GPS files can be accomplished by running the Data Transfer program
from within Pathfinder Office or by using the stand-alone program found in Start - Program
Files > GPS Pathfinder Office = Data Transfer.

To transfer GPS Rover files to the PC:

a. Select Utilities = Data Transfer.

b. The program will try to automatically connect with the unit. Depending on the GPS
receiver, it may be necessary to select to proper device.

c. On the Receive tab, click Add = Data File (for GPS Rover files).

d. Highlight desired files and click Open.

e. Click Transfer All.

This process is used to transfer Data Dictionaries, Waypoints, Background files, etc. to and from
the GPS receiver. Simply set the directionality tab to Send/Receive and select the desired file type
using the Add button.

B. Differential Correction
Differential Correction comes in two forms, real-time and post-processing.
1. Real-time correction

Real-time Differential Correction utilizes ground-based base stations that broadcast corrected GPS
positions either by using radio beacons or satellites. The following two categories are available at no
cost to the user.

a. WAAS
1. Most later model GPS units have the capability of using WAAS. The user can toggle the
setting on the receiver to enable/disable use of WAAS.
2. WAAS is line-of-site so the signal is easily disrupted by obstructions.
3. There are three levels of WAAS correction signal.
e correlated/historical
e regional level
e local level
It is a good idea to let the GPS unit track the WAAS satellite long enough to allow the
corrections to “settle”, roughly 5-10 minutes after a cold start or after losing signal for
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more than 5 minutes.
4. WAAS corrections are in Lat/Long WGS84.

b. NDGPS Beacon
1. Beacon corrections are in Lat/Long NAD83 (CORS96)
2. NDGPS site configuration -- http:/www.navcen.uscg.gov/AccessASP/NDgpsReportAllSites.asp
3. NDGPS status map -- http://www.navcen.uscg.gov/dgps/coverage/Default.htm
4. The GPS unit must have a beacon receiver which may require purchasing additional
equipment to use this service.

2. Post-processing

Post-processing differential correction of GPS files can be accomplished by running the Differential
Correction program from within Pathfinder Office or by using the stand-alone program found in Start
-> Program Files - GPS Pathfinder Office - Differential Correction.

NOTE: The Differential Correction wizard has been revised in version 3.1. If desired however, users
can still use the “Classic” wizard (refer to Appendix E) that can be found under Utilities 2 Other 2>
Differential Correction Classic.

To correct GPS Rover files:

a. Select Utilities = Differential Correction.

b. Recently downloaded files will be visible in the window. If the desired files are not, select
the files to be corrected by clicking on plus sign ‘+’, navigate to the proper location, highlight
and click Open.

c. After selecting the Rover files to be corrected, these should be visible in the Differential
Correction window, click Next.

d. In most cases, select Standard Code Processing Only and click Next.

e. At the correction settings screen, the user may elect to modify correction filters for the Rover
or Base files (click Change) or simply go with the defaults, click Next.

f. At the Base Data screen, the user must select one of three locations of base station data.
Typically, the user will download data from the Internet using the Base Provider Search. If the
desired base provider is not already listed, click Select... to access the provider list.
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g. Select the desired base station you want to use. Click Properties if you need to view a

o

1.

particular station’s attributes, including the reference position. Base files are good to within
500 kilometers (310 miles). For San Juan Public Lands users, refer to the Base Station Map in
Appendix B.

fimbie Fielerence Station version 1 01 |

(Compact L1/LZ with Grownd Flane
S seconds  MADE] (CORSIE) ‘

(35738°20 90606 N

106°57'41 I6656"W

2.075.394

It is recommended to periodically update the base station list in order to capture any changes to
the reference position as well as new stations. Click Update List.

Once a suitable provider has been selected, click OK.

NOTE: In choosing a provider, select a provider that has a high Integrity Index value (i.e. 80
or above) that is within your coverage area. If several stations are above 80, choose the one
closer to your area.

Click Next.

Select Use reference position from base provider if not already selected. Click OK.

NOTE: It is recommended that this value be periodically reviewed with against the published
coordinates on the Internet. If a reference position is incorrect, the user will be unable to
adjust the position for a base station in the CBS list within the Differential Correction Wizard.
The user will need to use Differential Correction Classic, create a custom station or manually
adjust the value in the CBS list.
On the Output screen, select the desired options. Click Start.
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m. Review the information displayed in the window. Click Confirm if needed.

n. Review the correction summary. Click Close when finished.
% Differential Correction Wizard

Precessivg rever file, Z0S07104.55F . =]
1o output file, €;'gs\projectigps\est\I0907194.cor
Code processing...
Salecked 375 positors for past-processing
Corrected 375 positions

Diffierential Correction Summary:
1 fils processed. [n this file:
375 (100.0%] of 375 selected positions wers oode corrected by post¢

Estimated acouracies for 375 comected positions are as follows:
Range Percentage

1-Zm 99.5%

Ciflarantial correction complets,

4] | _’lﬂ

< Back Close ael | e |

Tech Tip #3.1 Make sure you are using a relatively current base provider list (within 2 weeks of last
update).

#3.2 The location of the base provider list for Pathfinder Office is:

C:\Program Files\Common Files\Trimble\Config\cbs_list.csv
This is a different file in a different location than that used by GPS Analyst.

#3.3 You can create a custom base station for use in Differential Correction. This is useful if
you have a base station not on Trimble’s provider list or if you want to create a CORS96
station from a WGS84 station. The following example shows two colored icons. A red icon
means the station is listed in the cbs_list.csv file. A blue icon means it is a user created

custom station. Custom station information is stored in
C:\Program Files\Common Files\Trimble\Config\user_list.xml

X State of NM Mining & Minarals 212 km ?
M USFS Santa Fe MF 215 km 7
F Mesa County GPS/Surveying, MCO4 221 km 88.85

To create a custom station, refer to the process at:
http://fsweb.santafe.r3.fs.fed.us/gis/documents/GPS/integrate_local_base.pdf

C. Editing

Edit GPS files in Pathfinder Office to eliminate unwanted features and positions (vertices) first by
removing spikes, position strays and other errors in features.

1. To eliminate a feature:
a. Right-click on the feature = Delete > Yes.
b. Not In Feature positions will be visible where the delete position was. Remove these
if desired by using the Delete Block tool on the tool bar. It is recommended that
any feature layers be turned off before using this tool or you might delete additional
positions.
2. To eliminate unwanted positions:
a. Right-click on the position (vertex) to be deleted and select Delete Position. To
remove a group of positions, use the Delete Block tool.
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b. Save often. This will minimize the need to edit these errors in GIS making the data a
little easier to manage.
c. A deleted position or feature can be undeleted if needed.
3. Visually check the data to ensure it represents what was mapped in the field as much a
possible. Any major discrepancies should be documented. The intent is to have a file as clean
as possible prior to being loaded into a GIS.

D. Exporting — Converting Data into GIS

If your intent is to gather GIS data, setting up your export properly is one of the most important
things to do. You can control the resulting GIS projection from the export regardless of what
projection was displayed on the handheld unit. Most GPS receivers store data in WGS84 geographic
coordinates. If the export projection does not match the GIS, then the data will not be located in the
right part of the world.

Because of the one meter difference between the WGS84 and NADS83 datums, procedures for
converting WGS84 data to NADS3 correctly falls into various “Scenarios” and are outlined in detail in
the Trimble Support Note: GPS Pathfinder Office Software or the GPS Analyst Extension for ESRI

ArcGIS Software: Resolving the NAD 83 Datum Transformation Issue.
http://trl.trimble.com/docushare/dsweb/Get/Document-170369/SprtNote PFO-GPSA NAD83Datum.pdf

This one-meter difference is only critical to those individuals desiring sub-meter results.

. Figure 1 i
Datum of corrected positions ’ Datum of GIS coordinate systern
WGES-84 Scenario 1. No transformation required WGES-84
or other
Scenario 2:
Transformation

WGS-84 to NAD 83

Scanario 3:
Reverse Transformation
NAD 83 to WGS-84

Scenario 4: No transformation required

Trimble Navigation Ltd.

This document includes the proper settings for Scenarios #2 and #4 for Region 2 to eliminate the
one meter shift. For more detailed information, refer to the support note. A graphic showing correct

datum transformations from WGS84 to NAD83 and NAD27 can be found at the following address.
http://fsweb.sanjuan.r2.fs.fed.us/gis/GPS/NAD83 NAD27_ datum_transformations.pdf

1. Open the Export Utility in Pathfinder Office by selecting Utilities - Export from the main
menu. This will open the Export window.
2. Select the file(s) to export by using the Browse button.
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3. If needed, select the Output Folder by using the Browse button. The Output Folder is the
destination of where you want the exported files to go. This folder typically has been setup
during the project selection at the Pathfinder Office startup.

4. Choose an Export Format:

® Arcview Shapefile — good for all spatial features, field names truncate at 10 characters.

® MDB - good for points, maintains most field widths.

* Arclnfo

e ASCHI
NOTE: It is highly recommended that copies of these formats be used instead of the samples.
Make a copy of a setup using New Setup. You may want to make an export setup for both NADS3
CORS96 and NAD83 Conus settings.

5. Set the export settings to the Region 2 standard by clicking Properties. The Datum for Scenarios
#2 and #4 are listed below.

NOTE: It may be simplest to stick with one datum when using any base station to avoid confusion
if not concerned about sub-meter accuracy.

a. Coordinate System
1. Check Use Export Properties and click Change.

System: UTM
Zone: 13 North
Units: Meters
Datum: NADS83 (CORSY6) -- Scenario #2
Autonomous GPS or data corrected against WGS84 base station
OR
Datum: NADS83 (Conus) -- Scenario #4

Data corrected against NAD83 base station
2. If using Altitude reference (relevant for XYZ in 3D use), set to MSL,
Other 2 Geo0id99 (Conus)
3. Export coordinates as XY. Only use XYZ for 3D application.

b. Position Filter
1. Minimum Satellites set to 3D (4 or more SVs)
2. Maximum PDOP set to ALL. (PDOP standard is 6 and should be set in the unit.
Sometimes this number is adjusted by the user if satellite acquisition is difficult.)
3. Everything except UNCORRECTED is checked as default. Check uncorrected if
needing to include uncorrected data.

c. Units
1. Check Use Export Units. Set to Meters, square meters and meters per Second.

d. Attributes (personal preference)
1. Export Menu Attributes as:
e Attribute Value — The attribute value as defined in the Data Dictionary. Maximum
of 20 characters.
OR
e Code Values — The Code Value(s) as defined in the DD. Maximum of 6 characters.
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Pertains to Menu attributes only. Use is similar to geodatabase
domains.

2. Generated Attributes

Date Recorded

Data file Name

PDOP, HDOP

Receiver Type

Correction Type

Horizontal/Vertical Precision (68%, 95% or 99% confidence)

e. Output
1. Combine all input files and output to the export is checked.

2. Leave as windows files.

6. Once the options have been set, click OK. The settings for these formats will remain saved unless
manually changed by another user. On PCs with multiple user profiles, these setting may differ
from profile to profile. It is recommended to confirm the settings prior to running the export
utility.

7. Check to ensure the correct settings appear under the Export Setup. Click OK to export. The
message box should say X# features exported.

NOTE: If you inadvertently select points on the GPS unit when you intended to collect lines,
you can choose to export each individual GPS reading.

8. Read Export Completed window to check for a successful export. If there is an error in the
export process review the log file by clicking on More Details. A common error results from
trying to export files with mismatched data dictionaries. To resolve this, export the files with
different dictionaries separately.

9. Click Close. Depending on how many exports are performed, it may be necessary to put files
into multiple folders to avoid overwriting files. Export creates files based on feature name.

Tech Tip #3.4 You can export multiple files together.
#3.5 You can continue the ID increment from the previous session.
#3.6 Files with different data dictionaries will need to be exported separately.

E. Importing — Converting GIS Data into GPS for Field Use
1. GeoExplorer 3 & GeoCE series

GIS data can be in Shapefile or Waypoint format prior to importing.

In Pathfinder Office, select from the main menu Utilities = Import.

Click Browse to locate and select the file to import.

Select the Import Setup for Arcview Shapefile (recommend make a copy of the setup and
edit the copy).

ao o
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e. Set coordinate system properties if necessary.
System: UTM

Zone: 13 North

Units: Meters

Datum: NADS3 (CORS96) -- correct
OR

Datum: NADS83 (Conus) -- 1 meter of error
f. Click OK. The file created will have an .imp extension. This can now be transferred using
Data Transfer.
Select Utilities = Data Transfer.
Once connected, select the Send tab to transfer the file to the GPS unit.
Click Add - Data File.
Highlight desired files and click Open.
Click Transfer All.

SR s

Tech Tip #3.7 Symbols used in Pathfinder Office for displaying a particular file can have that same
symbology saved for use within Terrasync. Simply set the desired symbology in Pathfinder
Office and then save the file. The file can then be transferred back to the CE device for
display in Terrasync with the specified symbology.

2. GeoExplorer 3c

Since the Geoexplorer 3c lacks the ability to upload data files, a user desiring to take data back
out into the field must convert a shapefile (.shp) into a waypoint file (.wpt) somehow. The
following is probably the easiest method to use.

a. The Semi-Manual Method

GIS data should be in Shapefile format prior to importing.

In Pathfinder Office, select from the main menu Utilities = Import.

Click Browse to locate and select the shapefile to import.

Select the Import Setup for Arcview Shapefile (recommend make a copy of the
setup and edit the copy).

5. Set coordinate system properties if necessary. For SINF data, use:

Ll

System: UTM
Zone: 13 North
Units: Meters
Datum: NADS3 (CORS96) -- correct
OR
Datum: NADS83 (Conus) -- 1 meter of error

=

Click OK. The file created will have an .imp extension.

7. Open the new import file using File = Open. The file should now be visible
in the map window. It is recommended that the Feature Properties and
Position Properties windows are visible.

8. In the Main Menu, select File > Waypoints - New to create a new waypoint (.wpt)
file. Give a new name and location for the waypoint file. Click OK.

9. In the Waypoint Properties window, click Create.
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10. Check the box next to Pick From Map.

11. Using the black selection arrow, select one of the feature points of the imported file.
A new waypoint should now show in the Waypoint window and the feature should
have a square around it. Click Save to save the point. Repeat the create process as
desired. NOTE: You can view the Feature Properties to rename the new waypoint to

something meaningful.

12. When finished, click Close.

13. Click File > Waypoints - Close.

14. You can now connect to the datalogger and transfer the .wpt file.

F. GPS From a GIS Perspective — 10 ways to Make Your Trimble GPS Data Better

1.

2.

Plan Ahead — Use preplanning software to plan field time and conditions. Software like Quick
Plan and Trimble Planning Software help users determine the best times for data collection.

Use a Data Dictionary — A Data Dictionary is any method that standardizes data collection. Data
Dictionaries can range from the very simple to highly complex in the type of data being collected.
Dictionaries allow GPS data to be stored in features containing attributes and not just position
information. Dictionaries can be tailored to match existing GIS structures and standards. Before
heading to the field with a new Data Dictionary, TEST IT FIRST!

Use Precision Controls — Precision Controls like masks for PDOP, Elevation and SNR filter out
data that doesn’t meet desired standards. These can be set within the GPS receiver and Pathfinder
Office.

Adjust Logging Intervals and Occupation Time — Depending on the collection environment,
adjusting these values can improve or degrade the quality of your data.

Collect Velocity Data — Velocity Data can be used to improve the quality of your data in high
multipath environments.

Differential Correction — Real-time (good) and Post-processing (best) corrects satellite,
atmospheric and ionospheric errors which can be add over 10 meters of error to the location. Real-
time differential is a broadcasted signal (satellite or ground based) that can be hindered by
topography. Also, try to use a base station that is close to your area. Base files are good to within
310 miles. There is 2mm of degradation for every kilometer between the rover and the base.
Don’t wait! Download, Correct and Edit promptly — Some base stations limit how long base
files are retained. Correcting and editing the data ideally should be done by (or with) the person
who collected it while the GPS experience is still fresh in the mind. things to watch out for:
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Source: Joel Cusick, NPS Alaska Support Office

8. Use the Proper Coordinate System and Datum — Know what settings to use when moving your
GPS data into GIS. There is a difference between NADCON (the right way) and NAD27 (the
wrong way).

9. Generate Metadata — The textfiles generated during differential correction and export can help in
the creation of metadata. Metadata is required by law for Federal agencies. Executive Order 12906
(April 1994).

10. Consult With Your GIS/GPS Coordinator — These individuals can be a valuable resource.

IV. GPS Analyst

GPS Analyst is an ArcGIS extension that allows the user to work with GPS data directly within the

geodatabase format. Before using GPS Analyst, it is recommended the user review the notes at:
http://fsweb.sanjuan.r2.fs.fed.us/gis/GPS/NPS USFS GPS%20Analyst notes.pdf

GPS Analyst is subject to the same datum transformation issue between WGS84 and NADS3 as described
in Section III for Pathfinder Office. Because of the one meter difference, the same “Scenarios” exist for
the GPS Analyst procedures for converting WGS84 data to NADS3 correctly.

This document includes the proper settings for Scenarios #2 and #4 for Region 2 to eliminate the
one meter shift. For more detailed information, refer to the support note. A graphic showing correct

datum transformations from WGS84 to NAD83 and NAD27 can be found at the following address.
http://fsweb.sanjuan.r2.fs.fed.us/gis/GPS/NAD83 NAD27 datum_transformations.pdf

NOTE: GPS Analyst is a more advanced program requiring ArcGIS skills and may not be suitable for the
basic user. Even then, it may take time before a level of proficiency is achieved. This section will only
cover the Office Tools and not discuss data collection with GPS Analyst or GPScorrect.

GPS Analyst Toolbar (Office tools)
GFS Analyst

GFS Analyst =

WS R e s
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A. Data Transfer

Data Transfer of Trimble GPS files can be accomplished by running the Data Transfer program within
Pathfinder Office or the stand-alone Data Transfer Utility (available for download at:
http://www.trimble.com/datatransfer.shtml) for those without PFO.

For data transfer directions, refer to Section III or the programs on-line help.

B. Geodatabase Preparation

1. In ArcCatalog, make sure GPS Analyst extension is turned on. Tools = Extensions.
Create or use an existing geodatabase. Right-click on the geodatabase and select Properties -
GPS Analyst tab > GPS enable geodatabase.
3. Set the GPS spatial reference and transformation (import an existing UTM NADS3 zone 13N
spatial reference from another layer or select it from the projected coordinate systems).
Set the required datum transformation based on the type of base stations to be used. Click OK.
e NAD_1983_To_WGS_1984_5 -- Scenario #2
Autonomous GPS or data corrected against a WGS84 base station
OR
e NAD 1983 _To_WGS_1984_1 -- Scenario #4
Data corrected against NAD83 base station

>

Select Geographic Transformation _EIZI

“rou must select a geographic transformation to ensure that positions are correctly
converted from the GPS coordinate system to your nominated coordinate systerm.

Comvert frarm: IGCS_WGS_1 984
Inta: [GCs_Marth_american_1983
Using: <MNone> j

<MNone>
MAD_1983_To_WGS_1984_1
MNAD_1983_To_WGS_1984_2
MNAD_1983_To_WGS_1984_3
[NAD_1983_To WS 1954

4
5

NOTE: Set the appropriate datum transformation for the geodatabase in line with the base station
to be used for correction

Tech Tip #4.1 GPS disabling a geodatabase breaks the feature-link to the GPS data. Once a geodatabase
has been disabled from GPS, the underlying GPS data for the features is removed from the
database and cannot be re-linked to the existing features.

C. Loading GPS Data into Geodatabase

Import Trimble SSF files into the geodatabase. It is recommended the files be imported into a dataset,
but it is not required. A featureclass will be created for each data dictionary feature that exists,

regardless of whether there is data in that feature or not. The GPS sessions that have been imported
into the database will also be visible.
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Open the database/dataset and right-click and select Import - Trimble SSF.

After the data has been loaded, get into each feature’s properties and select the GPSAnalyst tab.

If desired, select (or create) the fields for storing the average and worst horizontal accuracy values.
Avg/worst accuracy values require a numeric field.

NOTE: Estimated accuracy in GPS Analyst is calculated at the 68% confidence interval only.
Some accuracy requirements (i.e. USFS GIS Data Dictionary) are based on a 95% confidence
interval or higher.

If desired, set the accuracy required for validation. This value can be used to determine if a feature
meets desired accuracies.

If desired, set the default construction values. These parameters govern how the feature will be
built (edited) by determining which GPS positions to use for the feature.

Tech Tip #4.2 The construction values set in ArcCatalog are independent of the same type of

construction values set in ArcMap.

D. Differential Correction

Differential Correction can be performed either through ArcCatalog or ArcMap. However, it may
be more useful to the user to post-process their data using ArcMap as any changes and edits the user
makes are more easily viewed there.

1.

2.

ArcCatalog
a. Open the GPS Session.

b. Right-click an the imported session.

c. Right-click on Differential Correction.

d. The Differential Correction Wizard will pop up and is the same as in PFO with the exception
of the addition of a rebuild settings dialog box.

ArcMap
Make sure the GPS Analyst extension is turned on. Tools = Extensions.

a
b. Add layer(s) to the map. Set the datum transformation (this does not appear to actually override
the transformation origianlly set during the setup of the geodatabase, but it is recommended the
same transformation be set anyway.)
Add GPS Analyst toolbar. Select View = Toolbars = GPS Analyst.
d. Start a GPS Edit Session. On the toolbar, select GPS Analyst > Start GPS Editing.

NOTE: A GPS Edit Session is different than a regular ArcMap edit session.

e. Select the Differential Correction icon ‘& to open the Differential Correction Wizard.

o

Differential Correction Wizard

a. Select the GPS session to be corrected by clicking on plus sign ‘+’, navigate to the proper
location, highlight and click Open.

b. After selecting the session to be corrected, this should be visible in the Differential
Correction window, click Next.

c. In most cases, select Standard Code Processing Only and click Next.

d. At the correction settings screen, the user may elect to modify correction filters for the session
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f.

g.
h.

I.
J-

Appendix B.

or Base files (click Change) or simply go with the defaults, click Next.
At the Base Data screen, the user must select one of three locations of base station data.
Typically, the user will download data from the Internet using the Base Provider Search. If the
desired base provider is not already listed, click Select... to access the provider list.

% Differential o

Select the desired base station you want to use. Click Properties if you need to view a
particular station’s attributes, including the reference position. Base files are good to within
500 kilometers (310 miles). For San Juan Public Lands users, refer to the Base Station Map in

nimble Reference Station version 1.01

Compact L1 /L2 with Ground Flane |
S seconds  MADEI (DORSIE) ‘

36738°20.90606 N

105°57'41. 36656 v

It is recommended to periodically update the base station list in order to capture any changes to
the reference position as well as new stations. Click Update List.

Once a suitable provider has been selected, click OK.
NOTE: In choosing a provider, select a provider that has a high Integrity Index value (i.e. 80
or above) that is within your coverage area. If several stations are above 80, choose the one
closer to your area.
Click Next.
Select Use reference position from base provider if not already selected. Click OK.
NOTE: It is recommended that this value be periodically reviewed with against the published
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coordinates on the Internet. If a reference position is incorrect, the user will be unable to
adjust the position for a base station in the CBS list within the Differential Correction Wizard.
The user will need to create a custom station or manually adjust the value in the CBS list.
k. On the Output screen, select the desired options.
At the rebuild window under the GPS Filter tab, initially it may be helpful that all Include
Correction Types are selected and the Filter by Quality options are unchecked. Feature quality
will be regulated using other Rebuild settings. However, it may become necessary to further
refine filter options if output quality is not as expected or desired.

Rebuild Settings - .

Position Selection  GFS Filter |

[a—

—Include Correction Types

v LUncoracteck W RealTime SBAS
Rebuild Settings - .
v Beal-Time Code ¥ Posiprocessed Code
Fasfiat SiElizsia | GPS Filter ¥ Feal-Time Cartier Float ¥ Postprocessed Carrier Float
—Use GPS positions ¥ RTE Fixed W Postprocessed Carrier Fixed
o crginal cellected arimported sessian
— Filter by Quality

" that are the most recent

@ with the best quality ™ Minimum Estimated Accuracy |5 000 m

" Dilution of Precision

= lyfesirmurm ZD0P [0 -]
€ blmximum HDOR f40 =

V¥ Replace manually edited geometry with GPS-derived geometry

m. Click OK. Click Start.
n. Review the information displayed in the window. Click Confirm if needed.
0. Review the correction summary. Click Close when finished.

NOTE: You can correct using many different bases stations and use the best data from multiple
stations.

Tech Tip #4.3 Make sure you are using a relatively current base provider list (within 2 weeks of last
update).

#4.4 The location of the base provider list for GPS Analyst is:
C:\Documents and Settings\All Users\Application Data\Trimble\GPS Analyst\cbs_list.csv

This is a different file in a different location than that used by Pathfinder Office.

#4.5 You can create a custom base station for use in Differential Correction. This is useful if
you have a base station not on Trimble’s provider list or if you want to create a CORS96
station from a WGS84 station. The following example shows two colored icons. A red icon
means the station is listed in the cbs_list.csv file. A blue icon means it is a user created

custom station. Custom station information is stored in:
C:\Documents and Settings\<user name>\Application Data\Trimble\GPS Analyst\User_list.xml

R State of NM Mining & Minerals 212 km ?
X USFS Santa Fe MF 215km 7
R Mesa County GRS/Surveying, MCO4 221 km B8.85

To create a custom station, refer to the process at:
http://fsweb.santafe.r3.fs.fed.us/gis/documents/GPS/integrate _local_base.pdf
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#4.6 Reference Positions
o  WGS84 datum = Autonomous GPS, WAAS and CORS stations.

e NADS83 (CORS96) datum = NDGPS (Coast Guard) beacons and many Community
base Stations (CBS).

E. Editing

Once the GPS data has been imported into the geodatabase, the featureclasses are linked to the GPS
session. Edits are made to the GIS features by using and adjusting the rebuild settings and path
constructions to refine the features to achieve the desired accuracy. It still may be necessary to
eliminate certain unwanted positions manually not effectively removed by the rebuild parameters.

In a GPS Edit Session, select a feature to edit. You can only edit one feature at a time.

. L ] ) . . .
Select the Edit Constructions icon "* to edit modify the construction properties.
Select Ring, Path or Smart Average Construction in the Edit Constructions window and click Edit.
In the Construction Properties window, determine the type of construction interval to use. More

than one construction type can be used but the top type checked will take priority over any others
checked. When finished, click OK.

el e e

| k | M Construction Properties N 71 x|
P
Flx]| ringsetings |
- Construction Interval
[=]- &rea_generic 6 =
é--Ring Construction I Time: 15 e
£ Track Construction Edit :
=-Location 1042 | W Distance: |5 000 m vl
- Location 1043
- Location 1044 Deleta | ™ Angle of Deflection
B Location 1045 Angler ID oooon® vl
- Location 1046
[#-Location 1047 T Distancs ID 0o m vl
- Location 1048
#-Location 1049 — Offset
[ Location 1050 Difeaten: Left -
- Location 1051 LI

B Harizontal Distance: ID 00d m vl

¥ Show GPS positions on the map

“ertical Distance: IU 000 m vl
oK | Cancel |
:\:l Ok | Cancel | Apply |

4

5. The Features in Progress line will change to the new constructed location in comparison to the
original line. Click OK to finish editing the feature. The following graphics show how part of a
polygon looks after being constructed using three different construction intervals from available
corrected positions (gray points).

a. Time =5 seconds
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b. Distance = 5 meters

NOTE: Working with the Construction Intervals takes practice. The types of constructions used
will depend on the situation of which will produce the best output. This also may vary feature to
feature.

Select the feature again and click the Select GPS Positions for Selected Features icon & (o0 show
the GPS positions selected for the feature location.

Select the Select All GPS Positions for Selected Features icon & to show the all GPS positions
for the feature. This includes uncorrected and positions generated from multiple differential
correction processes.

Select the Select GPS Positions icon &' to click or drag a box around positions that you want to
view more information about.

Select the GPS Position Properties icon = to view the detailed information about a position.

€] sition Properties x|

|Pusiti|:|n 5724 Field [ value [l
Position 1D 72
Morth 344,311.190 m
East 4,118,147.227 m
Altitude (HAE) 2,783,407 m
Antenna Height 0.914 m
Date 5/17/2006
Tirne 2105736 prm a
GPS Session Corrected 5-25-2006 8.09.... a
Selected as Location  Yes a
Velocity 2,36 mph a
Velocity Up -0.64 tph c
Heading 0° (T =
Estimated Accuracy  1.576 m La €
Sigma Morth 1387 m a a
Sigma East 0.610 m
Sigma Up 1.651 m a N\/a
Correction Type Code =]
Occupation Type Kinernatic u a §
Salution Time Postprocessed a Selected
Correction Source Single Base positions
Frequency Type L1

= positionz Frequency algorith...  MN/A -
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10. If desired, select the Rebuild icon ¥ to change the filter settings for the selected feature(s) and
rebuild the feature.

11. Select the GPS Feature Validation icon 2 to validate features against the established feature
accuracy requirements. You review, edit or mark the feature as an exception.
NOTE: Feature validation looks at each individual position’s accuracy and not the average
accuracy of the feature. Remember, this is only a 68% confidence.

GPS Faatura Velidation - |
¥ Show valid Features ¥ Show Exceptions 1 features are invalid, out of 1 GPS features validated.
Status | Exce... I Feature I Description | Required | Worst | Average | # Invalid I %o Invalidl
Insufficient ac... No Area_generic 1 patch 1 S000m 6163m 1896 m 3 1%

"N

12. You can delete individual positions manually using the Edit Constructions window. Select the
position location from the list. The selected position will be displayed on the map. Click Delete.
The position will be deleted and the constructed geometry will change. This may result in different
positions being used feature-wide based on the type of construction interval used. The red line is
the feature geometry after deleting one position. The green line was the original feature.

Edit Constructions I -[x]

#-Location 1056 ;I

#-Location 1057

#-Location 1058 Edit
+-Location 1059

+-Location 1060 J

#-Location 1061

#-Location 1063

oL ocation 1065
- Location 1066
#-Location 1067
+-Location 1068
+-Location 1069 =

E
E
E
[
[
[
[-Location 1062
E
E
E
[
[
[

¥ Show GPS positions on the map

0K | Cancel |

13. Click GPS Analyst - Stop GPS Editing to exit the edit session. Click Yes to save the edits.
14. When completely finished editing the GPS data, the user has options to:
a. GPS disable the geodatabase.
b. Export the completed features to a permanent geodatabase.
c. Load the features into an existing corporate geodatabase featureclass.
15. It can be beneficial to keep a copy of the geodatabase used for GPS editing for metadata purposes.
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Tech Tip #4.7 You can set the GPS position symbology using different attributes to help make
decisions during feature editing. You can use unique values or graduated symbols. Some
of the available attributes are included below.

Estimated Accuracy Correction Type Selected as Location
GPS Positions GPS Positions G s
Estimated Accuracy Correction Type Selected as Location
a (0.000-5000m a Corrected a Mo
@ 5.001-49.000m a8 Uncorrected a Yes
PDOP Correction Source
5

POOP GFE Positions

a 00-10 Correction Source
a 1.1-20 a Unknown

a z21-30 a Single Base

a 31-60 a Local Area Metwork
a 5.1-4930 a Wide Area Netwaork

#4.8 The user can edit the constructions of the feature as many times as necessary adjusting
the construction intervals to get the desired output.

F. Exporting Data for Field Use

1. In ArcCatalog, right-click on a layer, dataset or geodatabase and select Export - To Trimble

SSF - Features to SSF data file
Export to Trimble SSF or DDF B 2 =R

—Export

& Eeatures to SSF data file]
" Features to 35F data fils, and schema to data dictionary (DOF)

¢ Schema to data dictionary (DDF)

—Source

IC:\g|s\temp\hrtg_temp.mdb

—Destination
S5F Data File
IC'\gis\temp\hrtg_temp ssf = |

YWGS 1984 (HAE)

Data Dictionary File:
IC.\gis\temp\hrtg_lemp.ddf & |

oK | Cancel |

Tech Tip #4.9  You can create a Data Dictionary from the geodatabase structure that will utilize the
domains and attributes setup from the design of the database. Select Export - To
Trimble SSF - Schema to data dictionary (DDF).
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V. Garmin Receivers

A. Setup and Operation

NOTE: Different models have different levels of precision. A number of the Garmin GPS units on
the San Juan National Forest are GPS12 models. There may be a precision issue with these units
compared to other models and may yield slightly different results when used with Garmin GIS

utilities.

Due to the wide variety of Garmin units available on the market, it is impractical to describe each
unit’s usage in this document. Refer to the unit’s reference manual for detailed instructions.

B. Downloading — Converting GPS Data into GIS

1. Using DNR Garmin

DNOIVIIIDIY [t is not recommended that Garmin data be used as a substitute for resource
grade GPS work for inclusion into the corporate GIS. The quality of Garmin data can vary
depending on the units used.

a. Installation
Data transfer of waypoints and tracks from a Garmin hand-held unit can be accomplished
through the use of the DNR Garmin Extension for Arcview. This free program is available at
the following address. NOTE: for USFS users, uninstallation of this program requires
Administrative privileges.

http://www.dnr.state.mn.us/mis/gis/tools/Arcview/extensions/DNRGarmin/DNR Garmin.html

A “clean” install is required for DNR to operate correctly. NOTE: Administrative privilege
are not required but the install will not install the shortcut in other users’ profiles.

1.

2.
3.

4.
5.

b. Usage

Uninstall previous version of DNRGarmin. Start = Settings = Control Panel 2>
Add/Remove Programs.

Highlight DNRGarmin and select Remove.

In Windows Explorer, perform a search on local drives for all files named
dnrgarmin.* If found, remove.

Perform a search on local drives for all files named pcogarmin.* If found, remove.
Reinstall DNRGarmin.

The DNR Garmin program can be used within Arcview 3.x, but that is not covered here.

1.
2.

Connect the Garmin unit to the PC via a download cable.

Start DNR Garmin either by clicking on the desktop icon or Start - Programs 2>
DNRGarmin = DNR Garmin. The program will open and should automatically
connect to the GPS unit.

Select File = Set Projection to confirm the correct projection is set. For the San Juan
NF, it is NAD_1983_UTM_Zone_13N (as listed in ESRI format).
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B DNR Garmin Properties NN x|
Projection | ieypart | Track Foue | Rlimeiipt

POSC Codes: r EPSG  © ESAI

fpems =]
Datums/Projections:
[MAD_1983_UTM_Zone_13n =]

Dascription of Selected Projection:

<2691 3 -
+proj=ulm

+rane=13
+ellps=GRS80 =

PRJ File: Load PRJ |

OK_| Concel _Reset RO DN

4. Download POINTS

a. Select Waypoint 2 Download.

b. Select File > Save To > File.

c. Save as Type: Arcview Shapefile (Projected).

NOTE: Other file formats are available such as DBF and TXT.

d. Browse to the desired file location and name the file. Click Save.
5. Download LINES or AREAS

a. Select Track (or Route) = Download.

b. Select File > Save To = Arcview -> Shapefile = Point/Line/Poly.

c. Save as Type: Arcview Shapefile (Projected)

d. Browse to the desired file location and name the file. Click Save.

NOTE: Other file formats are available such as DBF and TXT.

. Using Waypoint+

Waypoint+ is a stand-alone utility that allows the downloading of waypoints, tracks and routes
from Garmin units. Coordinates are downloaded in Geographic WGS84, decimal degrees and
can be stored in a comma-delimited format. There are several ways to bring this into GIS,
Section IX, part 4 for ArcMap or Appendix I for ArcInfo. The program can be downloaded

from the following address. Refer to the program’s help section for operational instructions.
http://www.tapr.org/~kh2z/Waypoint/

UZLVWUWLER Waypoint+ maintains the data in Geographic WGS84 coordinates.

. Using GPS Utility

GPS Utility is a stand-alone utility that allows the downloading of waypoints, tracks and routes
from Garmin, Magellan and several other varieties of GPS units. Coordinates are downloaded in
Geographic WGS84 and can be saved in several formats, including shapefile. The program can

be downloaded from the following address. Refer to the on-line help section for instructions.
http://www.gpsu.co.uk/
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C. Uploading — Converting GIS Data into GPS for Field Use

1. Using DNR Garmin

a. Connect the Garmin unit to the PC via a download cable.

b. Start DNR Garmin either by clicking on the desktop icon or Start = Programs ->
DNRGarmin >DNR Garmin. The program will open and should automatically connect to
the GPS unit.

c. Select File - Set Projection to confirm the correct projection is set. For the SINF, it is
NAD_1983_UTM_Zone_13N (as listed in ESRI format).

1. Upload POINTS

o0 o

f.
g

Select File = Load From = File.

. Browse the file location.

Select the correct file type (i.e. Arcview Shapefile (.shp)). Click Open.

. Select a ID field (ex. ID) that is a number or text.

Select a comment text field, usually a description or name of the point. Click
OK.

Select Waypoint = Upload. This will transfer the points to the Garmin.
Click OK.

2. Upload LINES or AREAS

oo o

]

g.

Select File = Load From - File.

. Browse the file location.

Select the correct file type (i.e. Arcview Shapefile (.shp)). Click Open.

. Select a ID field (ex. ID) that is a number or text.

Select a comment text field, usually a description or name of the point. Click
OK.

Select Track = Upload. This will transfer the points to the Garmin.

Click OK.

2. Creating Custom GIS Maps for Use on a Garmin

The following Internet addresses lead to documents describing the process of how to create
custom GIS maps that can created and converted into a file that can transferred and used in many
models of Garmin GPS that allow the display of MapSource files as a background.

http://home.cinci.rr.com/creek/garmin.htm
http://homepage.ntlworld.com/mdipol/img2gps/
http://mapcenter.cepsmapper.com/

Admittedly, the process to create these custom maps is not easy and utilizes three separte programs
in order to achieve the desired result. However, there may be times when this may meet a specific
need. The following screenshot shows GIS data, including labels and symbology, that was
generated specifically for the map, even the contour lines.
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Tech Tip #5.1 -- Why does a Garmin list most of Region 2 in UTM zone 13S if we are in the northern

hemisphere? The following link explains this.
http://www.maptools.com/UsingUTM/UTMdetails.html

VI. Other GPS Receivers

A. Allegro Datalogger
Sally Zwisler — 5/13/2002

1. Setup and Operation

Documents on the use of the Allegro Datalogger and GPS receiver have been prepared
by Sally Zwisler and can be found on the server at:

http://fsweb.sanjuan.r2.fs.fed.us/gis/allegro_user_notes.doc
http://fsweb.sanjuan.r2.fs.fed.us/gis/allegro_wypts_process.doc

2. Data Transfer

http://fsweb.sanjuan.r2.fs.fed.us/gis/allegro_user_notes.doc

3. Uploading Waypoints to the Allegro for Navigation.

There are a couple ways to generate comma-delimited waypoint files in WGS84 coordinates
from shapefiles for use within the Allegro. The following procedure is probably the fastest and
requires Pathfinder Office.

a. Using Pathfinder’s Import Utility, follow Section 111, part E to create an .imp file.

b. Open the Export Utility in Pathfinder Office by selecting Utilities > Export from the main
menu.

c. Select the .imp file to export by using the Browse button.

d. If needed, select the Output Folder by using the Browse button.
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e. Create a new Export format called WaypntWGS84. Click New = New Setup =
Configurable ASCII. (This will only need to be setup once.)
f. Click Properties.
g. Configurable ASCII Tab
1. Click New. Name it arcmap (or waypoint).
2. In the Template Editor Window
a. Enter csv for the Output File Extension.
b. Apply to Points.
c. In the Worksheet Window, add the following.
{Latitude}{Longitude}{Feature ID}{Attributes}
d. Click OK.
h. Coordinate System Tab
1. Check Use Export Properties and click Change.

System: Lat/Long
Zone:

Datum: WGS84
Units: Meters

—

Once the options have been set, click OK.

j. Check to ensure the correct settings appear under the Export Setup. Click OK to export. The
message box should say X# features exported.

k. Read Export Completed window to check for a successful export.

1. Click Close. The new .csv file generated will contain coordinates in decimal degrees. The

table can now be edited in Microsoft Excel to add the necessary fields LandMark PC
requires. There is an 8-character limit for the name of the .csv file. Any longer,
and LandMark PC will not open the file.
m. In Excel you will see that the longitude value will already have negative sign (-). Arrange
data columns into the following order:
latitude longitude alt time fix pdop feature
37.364736  -107.354637 O 00:00:00 0 0 BLANG627_2
(example of data line)
a. Insert a — before the longitude if not already present.
b. Delete the header line, and all other columns of data.
c. Save as a .csv file in Excel.
n. Open the LandMark PC program on the desktop and bring in the 8 character .csv file that
you just created.
o. Export as waypnt file with WGS84 datum. (Under File 2 Datum be sure WGS84 is
seclected.)
p. Copy waypnt file onto ALLEGRO for waypoint navigating to plot locations.

Another way to generate the .csv file is detailed in the document prepared by Sally Zwisler.

http://fsweb.sanjuan.r2.fs.fed.us/gis/allegro_wypts_process.doc

B. GPS Receivers for Pocket PC’s

Refer to Section VII for using a GPS receiver with a Pocket PC and ArcPad.
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VII. ArcPad

ArcPad is a GIS program that can be run on any device that runs Windows CE or Windows Mobile for
Pocket PC. The San Juan NF currently has five CE devices that work with GPS receivers; the GeoCE
series, Trimble Recon, iPAQ Pocket PC with NavMan receiver, Dell Pocket PC with CruxIlI receiver and
the Allegro Datalogger. Setup for the Allegro is mentioned in Section V. This chapter will focus on key
program items of ArcPad and recommended GPS settings and is not intended to replace the ArcPad online
help.

To fully utilize this equipment, the ActiveSync program must be installed on the host PC. ArcPad must be
installed on the PC prior to installing on the CE device.

There are a variety of accessories that can be purchased to increase PDR functionality. For example,
external battery packs can increase battery life up to eight (8) times. Various brands of a sleeve GPS
receivers may use less power. A completely wireless GPS receiver is also available on the market.

Refer to the following FSWEB intranet sites for additional PDR and ArcPad information.
http://fsweb.ftcol.wo.fs.fed.us/frs/rangelands/pdr/index.shtml
http://sandy1.sandy.wo.fs.fed.us/terra_docs/articles/pdr-2.htm

IMPORTANT: Review Part C of this section on setting the correct GPS datum transformation in
ArcPad. This is critical when collecting either autonomous or differentially corrected GPS data.

A. GPScorrect with ArcPad (Trimble receivers)

NOTE: GPScorrect 2.0 is compatable only with ArcPad 7. GPScorrect 1.11 is compatable only with
ArcPad 6.03.

1. Setup

a. GPScorrect must first be loaded onto the CE unit. The following settings are

automatically set upon installation.
b. Start ArcPad.

Open the ArcPad Options i

d. Protocol Tab
1. Protocol > Trimble GPScorrect.
2. GPS - WGS84 (Do not change this!)
3. Height is optional.

e. GPS Tab

1. Port > COM3

2. Baud - 9600

3. Parity - Odd

13

2. GPS Settings

a. In ArcPad, click on the GPScorrect icon.
b. In Skyplot, click the wrench icon.
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c. Critical settings for data collection, includes PDOP, SNR (or C/No) and Elevation masks.
Settings may need to be adjusted in situations where satellite acquisition is difficult, but this
will affect accuracy. For Region 2, the default settings are recommended:

Max PDOP = 6 or HDOP =4

Min SNR =4 or C/No =39

Min Elevation = 15 degrees
d. Click OK. Close GPScorrect.

e. In ArcPad, open the ArcPad Options %~
f. Quality Tab

1. Select No Warnings. The GPS quality is controlled in GPScorrect.
g. Capture Tab

1. Check Enable Averaging.

2. Points = 120 (varies based on the user’s needs). The unit will not collect more than
the positions set. When in capture mode, you can save the feature before it has
reached the full number of positions averaged. There is a progress indicator on the
feature window and in the Geometry Tab of the feature.

Vertices = set only if you want to average vertices for lines/polys.

4. Streaming Vertices Interval - 5 (this is variable based on the user’s needs). This
setting is the logging rate for lines and polygons. In this example, the unit will
collect 1 vertex every 5 seconds.

d. Paths Tab

1. Set Default Maps & Data Path - \Disk\My Documents\<user created directory>

WARNING! Do not change the \System path!

»

NOTE: It is a good idea to create a folder in the \Disk\My Documents directory for all ArcPad
data. If a Hard Reset needs to be done, then data won’t be lost. For example:
\Disk\My Documents\arcpad_data

3. Differential Correction

a. Post-processing: Pathfinder’s ShapeCorrect utility

1. Connect the CE unit to ActiveSync.

2. Using Windows Explorer (not Internet), transfer all GPS shapefiles AND the .ssf file
created by GPScorrect to a directory on the PC.

3. Correct the .ssf file like any other Rover file. Refer to Section III, part B for the
correction process.

4. After the file has been corrected, open the ShapeCorrect utility by clicking on Start
-> Program Files = GPS Pathfinder Office = ShapeCorrect.

5. Click on Browse and select the shapefiles needing to be corrected.

6. Click OK. The shapefile has been adjusted using the corrected positions.

NOTE: This program applies corrections from a corrected GPS file to the shapefile. This
changes the original shape file and not a copy.

Tech Tip #7.1 IF correcting POINT shapefiles, the file must contain at least two (2) point features or
the shapefile cannot be corrected.
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b. Real-time: WAAS Differential (DGPS) collection

1.
2.
3.

In GPScorrect, click on Skyplot and switch to Setup.
Select Integrated WAAS.
Click OK.

B. Stand-alone ArcPad (iPAQ, Axim, GeoCE series, etc.)

1. Setup

NOTE: Pocket PC’s like iPAQ or Axim generally require the installation of certain files in order
to communicate with the specific GPS receiver being used with ArcPad and/or WAAS. Refer to
the Rangelands intranet site or the GPS manufacturer’s website for further instructions.

Standard NMEA collection

a. iPAQ 3900 series, Axim X5

1.

A

Open GPS Setup from Programs or the quick launch in Pocket PC. On access, this
will return the CE device GPS setup back to the default NMEA configuration. This is
standard, non-differential collection (3D, 2D).

Close GPS Setup.

Start ArcPad.

Open the ArcPad Options e~

Protocol Tab
a. Protocol > NMEA 0183.
b. GPS > WGS84 (Do not change this!)
c. Height is optional.

. GPS Tab

a. Port 2 iPAQ 3900 series - COM 6, Axim X5 — COMS
b. Baud = iPAQ 3900 series - 57600, Axim X5 — 4800
c. Parity > None

b. GeoCE series (using GPS Controller)

1.

2.
3.

Start ArcPad.

Open the ArcPad Options i

Protocol Tab
a. Protocol > NMEA
b. GPS = WGS84 (Do not change this!)
c. Height is optional.

GPS Tab

a. Port > COM2

b. Baud - 4800

c. Parity > None
Start GPS Controller.

. Click on the wrench icon ﬂ to access the GPS settings screen.

Scroll down and switch NMEA output to ON. Click on the wrench icon ﬁ
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8. Verify the settings match those in ArcPad.
NOTE: For using the TSIP Protocol on a Trimble receiver, refer to Appendix G.

Tech Tip #7.2 It is recommended the GPS Protocol datum be left in WGS84. Changing this can
adversely affect accuracy. The only time this may be changed is if connected to GPS
receiver (like a Garmin) streaming NMEA data with the display datum set to
something other than WGS84.

2. GPS Settings
In order to obtain quality GPS data in the field, the following ArcPad settings are recommended.

a. iPAQ 3900 series, Axim X5

a. In ArcPad, open the ArcPad Options -
b. Quality Tab
1. Select Compulsory Warnings. This makes any quality masks that are set manditory.
The unit will not use GPS data that does not meet these settings. (Non-Compulsory

Warnings gives the user the option to accept or reject data that does not meet the
desired setting.)

2. Check Maximum PDOP - 6.

3. Check 3D Mode Only.

4. If only DPGS data is desired, check DGPS Mode Only. WAAS must be enabled.
c. Capture Tab

1. Check Enable Averaging.

2. Points = 120 (may vary based on the user’s needs). The unit will not collect more
than the positions set. When in capture mode, you can save the feature before it has
reached the full number of positions averaged. There is a progress indicator on the
feature window and in the Geometry Tab of the feature.

Vertices = set only if you want to average vertices for lines/polys.
4. Streaming Vertices Interval - 5 (this is variable based on the user’s needs). This

setting is the logging rate for lines and polygons. In this example, the unit will
collect 1 vertex every 5 seconds.
d. Paths Tab

1. Set Default Maps & Data Path - \Disk\My Documents\<user created directory>
WARNING! Do not change the \System path!

»

b. GeoCE series (using GPS Controller)

1. With ArcPad open, start GPS Controller (F1 key or locate in Program Files).

2. In Skyplot, click the wrench icon.

3. Critical settings for data collection, includes PDOP, SNR (or C/No) and Elevation
masks. Settings may need to be adjusted in situations where satellite acquisition is
difficult, but this will affect accuracy. For Region 2, the default settings are
recommended:

Max PDOP = 6 or HDOP =4
Min SNR =4 or C/No =39
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Min Elevation = 15 degrees
Tech Tip #7.3 It’s recommended to create a folder in the \Disk\My Documents directory for all
ArcPad data. If a Hard Reset needs to be done, then data won’t be lost. For example:
\Disk\My Documents\arcpad_data

3. Differential Correction

a. Post-processing
Post-processed DGPS is not available for stand-alone ArcPad, only Real-time.

b. Real-time: WAAS Differential (DGPS) collection — iPAQ, Axim

1. Open GPS Setup from Programs or the quick launch in CE. On access, this will return
the CE device GPS setup back to the default NMEA configuration.

2. Select Start Configuration to switch from NMEA to WAAS. Three additional buttons
will become active.

3. Select DGPS Settings > WAAS Correction. This will only need to be enabled once
for WAAS.

4. Close GPS Setup. WAAS will remain enabled until GPS Setup is accessed again.

NOTE: WAAS requires FULL power from the Pocket PC unit. This will reduce battery life
35-40 minutes on a 2-3 hour battery. Also, WAAS DGPS reception can be intermitent. In
general, expect to collect both GPS and DGPS data with WAAS enabled, unless the DPGS
option is made manditory in the ArcPad Options.

¢. Real-time: WAAS Differential (DGPS) collection — GeoCE series
1. In GPS Controller, click Real-time settings.
2. In Choice 1: select Integrated SBAS (or WAAS).
3. In Choice 2: select Use Uncorrected GPS. Click OK.

C. GPS Datum Transformation Setup

GPS data can shift up to several meters from the correct location when not using the correct datum
transformation from WGS84 into NADS3 or NAD27.

This section will only address the one-meter difference between WGS84 and NADS83. For more

information, refer to the Trimble Support Note: GPS Pathfinder Office Software or the GPS Analyst

Extension for ESRI ArcGIS Software: Resolving the NAD 83 Datum Transformation Issue. Refer to

Appendix J for NAD27 settings.

NOTE: The correct Transformation ID to use depends on whether you have ArcPad 6 or ArcPad 7.
1. ArcPad 6.0.3

One of two datum methods must be set within the Layer Properties using the datum transformation

option 2. These solutions listed are recommended if you want to remove the 1 meter "error".
The simplest option is to stick to transformation #8494 to avoid the confusion of switching
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between datum transformations.

If using Stand-alone ArcPad, autonomous uncorrected GPS data
8494 (10.991, 1.9072, 0.5129, -0.025789907519493, -0.009650098960270, -0.011659943232342) /* (PE_GT_NAD_1983_TO_WGS_1984_5)

If using with GPScorrect or WAAS -- correcting against a WGS84 referenced base station
8494 (10.991, 1.9072, 0.5129, -0.025789907519493, -0.009650098960270, -0.011659943232342) /* (PE_GT_NAD_1983_TO_WGS_1984_5)

If using with GPScorrect or NDGPS -- correcting against a NADS83 referenced base station
8088 (0, 0,0) /* (PE_GT_NAD_1983_TO_WGS_1984_1)

# Layers e 2 B
| Title (i W
[ 82GPS Tracklog

I Elmap Grid

¥ Ehimdbdy.shp MO

M Datums e

Name | [ Tranp | Methad | spheroid | & |17 DX DY DZ RX RY RZ SF
D_North.. 6260 | 9088 | Geocentric_Translation | GRS_1980 | 6378137 | 298.2572.. 0 0 0 0 0 0 0
D_North.. 6269 | 9154 | Geocentric_Translation | GRS_1980 6378137 | 298.2572.. -2 0 4 0 0 0 0
D_North.. 6268 | 8155 | Geoceniric_Translation | GRS_1980 | 6378137 | 298.2572.. |1 1 -1 0 0 0 0
D_MNorth.. 6268 | 8232 | Coordinate_Frame GRS_1980 | 6378137 | 298.2572.. |-0.9738 19453 | 0.5486 | -0.02755.. | -0.01004.. -0.011358 0
D_North.. 6268 8434  Coordinate_Frame GRS_1980 6378137 298.2572.. -0.991 19072 05129 -002578.. -0.00965.. -0.011653.. 0O
2. ArcPad 7

The scenarios are the same as in ArcPad 6, but there has been a change in the way the datum
transformations are set within the program as well as the Trans ID’s. Trans# 1515 is set as the
default datum transformation so the user will not need to change this unless a NADS3 station.
If a NADS3 beacon or base station is used, this will transform the datum twice and will result in
one meter of error unless Trans# 1188 is used.

If using Stand-alone ArcPad, autonomous uncorrected GPS data
1515 (-0.991, 1.9072, 0.5129, -0.025789907519493, -0.009650098960270, -0.011659943232342) /* (PE_GT_NAD_1983_TO_WGS_1984_5)

If using with GPScorrect or WAAS -- correcting against a WGS84 referenced base station
1515 (-0.991, 1.9072, 0.5129, -0.025789907519493, -0.009650098960270, -0.011659943232342) /* (PE_GT_NAD_1983_TO_WGS_1984_5)

If using with GPScorrect or NDGPS -- correcting against a NADS83 referenced base station
1188 (0,0, 0) /* (PE_GT_NAD_1983_TO_WGS_1984_1)
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D. ArcPad Tips
1. Map Projections

a. ArcPad’s default map projection is WGS84.

b. When using SINF data, a projection file (.prj) must accompany the shapefiles over to the CE
device. The projection file tells ArcPad what coordinate system the data resides in. For the San
Juan, it is UTM, NADS&3 Zone 13.

c. IMPORTANT: When creating a new GPS shapefile in ArcPad, add a projected UTM, NADS83
layer to the map before creating the GPS file. This sets the map to the projected layer’s
coordinates, in this case UTM. Otherwise, the new GPS shapefile will inherit the default map
projection of WGS84 and require a conversion in order to display with any of the forest data.
Another way is to use an existing projected file (with or without data) for the GPS data.

2. Features

a. ArcPad is similar to ArcMap in symbology and functions.
b. Multiple layers can be in edit mode simultaneously.

c. Three key buttons control the collection of GPS data in the Edit toolbar. AR 1) The first
button on the left captures a Point feature with the GPS. 2) The second captures a single GPS
vertex in a Line or Poly. The user initiates this each time a vertex is desired. 3) The third button
continuously captures GPS vertices for a Line or Poly at a set interval based on the Streaming
Vertices Interval value set in ArcPad Options. Logging can be toggled on or off by tapping
this button.

d. The GPS Position Window will show GPS status, satellite information, compass, PDOP, etc.
This is independent from GPScorrect’s and GPS Controller’s SkyPlot. The display format of
the GPS information comes in a number of available formats.

e. You can manually enter a coordinate value for a point by creating a new feature (either
manually or with the GPS) and editing the feature’s location in the Geography tab.

f. A number of Applets (similar to extensions) are available for download off of ESRI’s
website.

VIII. GPS-Photo Link

GPS-Photo Link is an excellent way to spatially link digital photos with GPS data. This can be used to
easily create webpages containing the digital photos, GPS location and time, maps and metadata.
Requirements include:
e Digital camera
Garmin or Trimble GPS receiver
GPS-Photo Link software — http://geospatialexperts.com
Internet connection
ArcGIS

Refer to the software manual or on-line help for detailed instructions on use.
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This following is an example of the Index webpage that shows:
e Thumbnails of all the photos processed for the project.
e The selected photo with watermarked text including location, time, description, etc.
¢ Photo location on maps automatically accessed from the Internet.

e Metadata about the photograph.

Section corner

Survey marker signs

Photos

click an phata for
facation details

(8 iew

Survey marker signs

M est Street maps and Aerial Photos
Topo Zone Topographical Maps
Lost Quidoors Aerial Photos

TerraServer Maps Street Maps and Satellite Photos

|Title Section corner

| Comment Survey marker signs
Location (Lat/Lon) N 37° 20.067' W 107° 07.729"
|Location (UTM) |13 N 0311405 4134101
Datum \NAD 83

Time | 05/08/2006 7:28:13 PM

| Time Zone | (GMT-06:00) Mountain Daylight Time
I Camera Make Konica Minolta Camera, Inc.
|CameraModel | DIMAGE Z2

| Camera Sofiware | DIMAGE Z2 VerL.02
Original File | PICT0006.JPG

In ArcMap, the user can load the auto-generated photo shapefile, view thumbnails of each photograph,

view the full-size image i

n a graphics program, load the picture as a layer and access the webpage.

y ® Loed Background Image.

Tech Tip #8.1 It is important to synchronize the digital camera clock with the GPS clock prior to
collecting data and taking photos. This makes it easier to match up the photos with the

spatial locations.
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IX. ArcGIS - Additional GPS/GIS Operations
A. ArcGIS (ArcMap, ArcCatalog, ArcToolbox)
1. Defining the Projection of a Shapefile or Feature Class

a. ArcCatalog
1. In ArcCatalog, right-mouse click on the feature to set the projection for and select
Properties.
2. Click on the Fields tab and, under Field Name, single-click on Shape to activate the
field properties.

Spatial Reference

3. Click on the | Properties button located next to Spatial Reference | Unknown to
open the Spatial Reference Properties window.
Click on Select. Browse to find the desired projection. Click Add.
Click OK. You will now notice the Spatial Reference contains the selected projection.
In this example, NAD_1983_UTM_ZONE_13N. The layer has been projected to the
correct coordinates.
Default Shape field fes
ISpatiaI Reference MAD 1953 _UTM_Zone_13M H

6. Click OK. Close ArcCatalog.

oos

b. ArcToolbox
1. In ArcToolbox, open Data Management Tools 2 Projections and Transformations
- Define Projection.
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AveToolhax o

=@ Data Management Tools =]
=& Datsbase

+-& Disconmected Editing

+-8 Domains

o8 Faature class

[

[

[

- & Features

& Fields

& General

=& Generalization

=& Indexes

=& Joins

#-& Layers and Table Views
=& Projections and Transformations
& Feature

[+

ction
Fawotites | Index | Search

2. The Wizard will then guide you through the steps.
3. When finished, close ArcToolbox.

2. Changing the Projection of a Shapefile using ArcToolbox

a. WGS84 > NADS3
1. In ArcToolbox, select Data Management = Projections and Transformations 2>
Feature - Project
2. Browse for the Input Dataset you need to change the projection on. Click Add. The
shapefile will now be visible in the window. The shapefile must already have a defined
projection.

3. Specify an output location using the browse if needed. Name the new file.
4. Select the output Coordinate System. Click OK when finished.
5. Set the Geographic Transformation to NAD_1983_To_WGS_1984_5.
Input Dataset or Feature Class
IC'\g\s\lemp\temp shp EI
Qutput Dataset or Feature Class
IC.\g\s\lemprrU]ed.shp EI
Output Coordinate System
INAD_T 983_UTK_Zone_13W
Geographic Transformation (optional)
MNAD_1983_To_WGS_1984_5 il
=
9. Click OK.

10. Click Close.

NOTE: Remember to use NADCON when transforming between WGS84/NADS83 and
NAD27.

3. Exporting Shapefiles to Other Formats (Geodatabase, Coverage)
a. ArcCatalog

1. Right-click on the shapefile and choose Export = To...
2. Select the filename and output location. Click OK.
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b. ArcToolbox
1. Expand Data Management-> Conversion Tools.
3. Select the desired export file type.
5. Follow the wizard directions. The shapefile(s) must already have a defined projection.

NOTE: It is recommended that the precision value in the coverage environment settings be
set to Double.

4. ASCII Format — Adding XY Data From a Table/Textfile

Tables containing XY positions and attributes can be converted into point feature classes a
couple of different ways using ArcCatalog and ArcMap. Common files ArcMap can use are
TXT, DBF and CSV.

a. Textfile format for adding XY data

Prior to adding XY data from a textfile into ArcGIS, it is important to have the textfile in the
correct format.

1. Projected Coordinates
If using projected coordinates (i.e. UTM, NAD&3), an example of a simple format that
can be created in Notepad, WordPad or any text editor that can save in comma-delimited
format (.csv, .txt) is as follows:

East, North, Comment
358000, 4120233, gate
322300, 4129000, diversion

The top row contains the field names. East is the X, North is the Y and Comment is the
attribute. The textfile can be made more detailed if desired.

2. Geographic Coordinates
If using geographic coordinates (Lat/Long), the coordinates must be in decimal degrees
for ArcGIS to be able to read them. The following format is an example:

Longitude, Latitude, Comment
-107.000594373, 37.250005671, SE Pagosa Springs

The top row contains the field names. Longitude is the X, Latitude is the Y and Comment
is the attribute. Note the negative sign (-) before the longitude value. ArcMap
requires this for coordinates in the western hemisphere.

Tech Tip #9.1 Remember to keep track of what projection and datum the coordinates came from as this
will need to be specified in ArcGIS.
#9.2 Also, if the coordinates are WGS84, then the dataframe transformation method will also
need to be set correctly.
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b. Adding XY Data

1. ArcCatalog
a. Open ArcCatalog and find the table containing the coordinates.
b. Right-click on the table and select Create Feature Class = From XY Table.

L a

[ 2] L] oo
-
P Copy CirkC Specily output shapefile arfeature class
[N
[ o el [Chgisttermpymy_sample mdktry EI
Renatne Fz
ar.
2] we Export » Carfiguration kesmord

. l

Create Feature Class From

~InputField

®Field
[EASTING

¥ Field
[NORTHING

ZField:

[ <one>

Spatial Reference of Input Coordinates. |

2 LoG 7 From Boute Event Tabls

2 Lotus €3 Geocode Addresses.. From X Tahle...

é Properies I‘Ein a table

c. Select the fields that contain the X and Y data (i.e. Easting and Northing).

d. Select Spatial Reference of Input Coordinates and set the native projection of the
coordinates.

e. Specify an output location, be it a shapefile or within a geodatabase.

f. If necessary, set the output projection in Advanced Geometry Options if the native
coordinates are different than the desired coordinates (i.e. State Plane to UTM).

g. Click OK. The new feature class (including attributes) has been created and can be
added as a layer in ArcMap.

2. ArcMap

a. Select Tools 2 Add XY Data.

b. Select a table from the dataframe or browse for the file.

c. Select the fields that contain the X and Y data (i.e. Easting, Northing or Longitude,
Latitude).

d. Select Spatial Reference of Input Coordinates and set the native projection of the

coordinates.

Click OK. There is now a new event layer derived from the table in the dataframe.
This can be saved as a Layer File or exported as a feature class.

b. Adding XY Data (DMS)

Tables containing XY positions in Degrees Minutes Seconds (DMS) format can be converted into
point feature classes using ArcMap. Common files ArcMap can use are TXT, DBF and CSV.

NOTE: This custom tool is included in the ArcObjects Developer Kit and must be installed in

ArcMap prior to use. The extension is can be located at the following address.

C:\Program Files\ArcGIS\DeveloperKit\samples\Cartography\Layers\XY_DMS_Tool\Visual_Basic\XY_Events.dll

1. Textfile format for adding XY (DMS) data (Geographic Coordinates)
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The coordinates must be in degrees minutes seconds for ArcGIS to be able to read them.
The following format is an example:

Longitude, Latitude, Comment
107 15 35.25wW, 37 25 32.22N, Trailhead

The top row contains the field names. Longitude is the X, Latitude is the Y and Comment
is the attribute. Note the ‘W’ and ‘N’ after the values no no negetative sign. The tool
requires the hemisphere values be included.

2. Adding Data
a. In ArcMap, click on the Add XY (DMS) tool & .
b. Browse for the file containing the coordinates. The tool will convert CSV and TXT
files to DBF automatically.
c. Select the correct X, Y and delimiter fields.
d. Set the correct spatial reference.
e. If desired, set the name of the Events Layer to be created.

s Add XY (DMS) Data
~Table
Select a table
new_points{Comverte) -l 4
[~ and Y coordinat
X Field ¥ Field
Long_ | Lat |
Cantent Cantent:
107 15 25.55W 3725 30.22N
Delimiterin X Fiald Delimiter in Y Field
<Space> | [<Space> =l
Preview: Preview:
-107.257087222222 37.4250611111111
[ Spatial Referencs
GCS_North_Amsrican_1383
— Outpu
LayerName: <y Data
OK Cancal

f. Click OK.
g. Review the layer to determine if the data was added correctly.

SJNF Coordinate Toolbar v1.2

Coardinate Taals ~— ]

Set Projection ¥ Lat/Long Coord ¥ UTM Coord ¥ | & StoreGraphic | @ OMS 2 | Alter SRv B2 Q

The SINF Coordinate Toolbar is part of a custom ArcMap project developed for the San Juan NF
by Mark Roper who compiled existing tools as well as modified VB code to apply the tools to
Region 2.
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The toolbar is useful for quickly entering a few hardcopy coordinates and displaying as graphic
points, populating projected or geographic coordinates in the attribute table, setting the spatial
reference of an unprojected In the future, this may be put into the form of a DLL. The toolbar
consists of 10 parts.

Toolbar project -- http:/fsweb.sanjuan.r2.fs.fed.us/gis/coord_tools v1-2.mxd
Toolbar documentation -- http://fsweb.sanjuan.r2.fs.fed.us/gis/tools-programs/coordinate_toolbar.pdf

NOTE: Originally designed in ArcGIS 8.3, every tool EXCEPT the StoreGraphic tool in the
toolbar works in ArcGIS 9.0. I hope to fix this at some point, but you can install the stand-alone
Graphics to Features tool from http://arcscripts.esri.com/details.asp ?dbid=11786

You can also use the Convert Graphics to Shapes feature in XTools Pro.

1. Set Projection — quickly set Data Frame projection

Lat/Long Coord -- Enter Latitude and Longitude coordinates and display on-screen

UTM Coord -- Enter UTM coordinates and display on-screen
StoreGraphic—Store-Graphie-n-atayer—- broken tool -- install independent Graphics to Features

tool -- http://arcscripts.esri.com/details.asp?dbid=11786

2 Add geographic or projected coordinate values to the attribute table
DMS -- Add Degrees Minutes Seconds values to table

d . Degrees Minute Seconds calculator
Alter SR — Set spatial reference for an undefined NAD83 or NAD27 layer

B

Sl

L o W

-- Show coordinates with cursor

10. ‘% _ Show Lat/Long at mouse click

6. Exporting a GeoTIF to Convert to MrSID for Use in TerraSync or ArcPad

This can really be beneficial for users of TerraSync who deal with the limitation of one
background file at a time. This will enable users to display a map containing multiple pieces of
information, including labels and graphics, as a single image. You can convert the image to MrSID
(making a much smaller image size) using ArcCatalog so long as the source image is under SOMB.
ArcPad users could use this too. Larger files will require a MrSID license.
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. Blanco "%
. River Roac

a. *Exporting a map to create a georeferenced image
1. In the DataFrame window in ArcMap, select the File menu and click Export Map.

2.

SNk W

8.
9.

Navigate to where you want to save the export file.

Click the Save as type dropdown arrow and click TIFF or BMP.

Type a name for the export file.

Click the Options button.

To add georeferencing information, turn on Create world file (*.tfw for TIFF, * bpw
for BMP) when you export. This option is only available when you export while in
the data view.

Set the desired Resolution. Remember, the larger the number, the larger the filesize.
I recommend not exceeding 600 dpi.

Click OK.

Click Export. This creates two files, .tif and .tfw.

*Portions of this process were taken from ESRI’s ArcMap Desktop Help

b. Generating a MrSID Image

1.
2.

b

Once the georeferenced TIFF or BMP images have been created. Open ArcCatalog.
Navigate to the file location. Check the file size. It must be below 50 MB or else you
will need a full MrSID license or access to ERDAS.

Right-click on the file name. Select Export = Raster to MrSID.

Select a Compression Ratio in the range of 20 to 40. (This affects the resolution of the
image.)

Select the Output Raster location.

Click OK. Assuming there are no errors, the MrSID can now be transferred to the
GPS unit for use with TerraSync or ArcPad.
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X. Metadata

GPS Metadata is data about the data collected. How was the data collected? With what and when? What
were the GPS and export settings and accuracies? Is the data differentially corrected? The list goes on.
Metadata is available for the GPS data itself and the post-processing phase. Metadata is useful in
determining data quality, validation, source, etc. The federal government is required to maintain metadata
for GIS layers. The Federal Geographic Data Committee (FGDC) is responsible is the governing body for
metadata standards.

A. Reference Materials

Geospatial Metadata Standards — http://www.fgdc.gov/metadata/geospatial-metadata-standards

Top 10 Metadata Errors — http://www.fgdc.gov/metadata/documents/top 1 Ometadataerrors.pdf

Metadata Quick Guide — http://www.fgdc.gov/metadata/documents/MetadataQuickGuide.pdf

GPS standard for GIS (draft) WO — http://www.fs.fed.us/database/gps/gps_standards/GPS_Data_Standard.pdf

B. Attributes

There are a number of attributes available to be included in the shapefile during the export that contain
information about the GPS data. The example shows only a partial list.

Max_PDOP Max_HDOP Corr_Type Rcvr_Type GPS_Date GPS_Time Datafile Data_Dicti Horz_Prec
5.9 2.4 Real-time SBAS Corrected GeoXT 5/8/2006 07:15:31pm Z050819A.cor Generic 2179
3.2 1.8 Postprocessed Code GeoXT 5/8/2006 08:08:20pm Z050819A.cor Generic 1.620
48 3.0 Postprocessed Code GeoXT 5/8/2006 08:11:51pm Z050819A.cor Generic 2.336

Another metadata attribute item used called the Data Source comes from the Forest Service’s GIS Data
Dictionary. This manditory field for many GIS layers identifies how the data was acquired, whether by
GPS or some other method (i.e. topographic maps). The codes referencing GPS are as follows:

a. 02— GPS - 2-5 Meter, 3-D c. 04 — GPS - Survey Grade and Sub-meter

b. 03 — GPS - 2-5 Meter, 2-D d. 10 — GPS — >5 Meter Receiver
NOTE: Code 10 isn’t native to the Data Dictionary but was added to cover recreational grade GPS data.

C. Other Sources

Other main sources of metadata are the .txt and .inf files generated during differential correction and
exporting. Metadata of lesser value includes the basic log files generated during imports or rover file
audits. The following example shows only a partial list of the information included an .inf file generated
during Export.

Position Filter Details

Setting Type Value Setting Type Value
Filter By GPS Criteria Postprocessed Carrier Fixed |Yes
Maximum PDOP Any Non-GPS Yes
Maximum HDOP Any Coordinate System UT™M
Min Number Of SVs 2D (3 or more SVs) | |Coordinate Zone 13 North
Uncorrected Yes Datum NAD 1983 (CORS 96)
P(Y) Code Yes Coordinate Units Meters
Real-time SBAS Yes Altitude Units Meters
Real-time Code Yes Altitude Reference MSL
Postprocessed Code Yes Geoid Model GEOID99 (Conus)
Real-time Carrier Float Yes Distance Units Meters
Postprocessed Carrier Float | Yes Area Units Square Meters
RTK Fixed Yes Velocity Units Meters Per Second

Precision Units Meters
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D. Accuracy

The USFS GIS Data Dictionary also includes requirements for reporting horizontal accuracy in the
metadata record. The following is taken directly from that document.

Horizontal Accuracy:
Accuracy testing must use NSSDA testing guidelines or be reported based on compiled, published test reports appropriate for
the data collection method and equipment.

The method of determining accuracy should be documented in the process step of the dataset metadata record. If published
accuracy results are used, use the statement ‘Compiled to meet ___ (meters, feet) horizontal accuracy at 95% confidence
interval’ in the metadata record, and identify the testing source used. If accuracy is locally tested to NSSDA standards, the
statement ‘Tested to meet ___ (meters, feet) horizontal accuracy at 95% confidence interval’ should be added to the metadata
record.

Accuracy for legacy data may be reported according to the accuracy standard in place at the time of data collection (typically
National Map Accuracy Standards). Document the standard used in the metadata record.

Refer to the Forest Service’s GPS Data Accuracy Standard (DRAFT) Section 4: Accuracy Reporting and
Metadata document for more information.
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Appendix
A. Credits

Besides myself, the following individuals contributed information for this document. My apologies to
anyone I may have missed.

Dan Greene (R2, USFS) Michele Huffman (R6, USFS) John Varner (R2, USFS)
Sally Zwisler (R2, USES) Charlotte Quarnburg (R4, USES) Geri Morris (R2, USES)
Tom Effinger (R2, USFS) Tim Loesch (MN, DNR) Ros Wu (R2, USES)

Carl Sumpter (R2, USFS) Joel Cusick (Alaska, NPS)

References, program documentation and screen captures were used from software/sites provided by:

Official Forest Service GIS Data Dictionary 2004
USDA Forest Service

ArcGIS, ArcMap, ArcCatalog, ArcToolbox, ArcPad, Arcinfo, and Arcview are registered trademarks of:
Environmental Systems Research Institute, Inc. (ESRI)
380 New York Street. Redlands, CA 92373-8100. 1-909-793-2853

Pathfinder Office, GPSAnalyst, Trimble Planning, GeoExplorer 1, 2, 3, XM/XT, Pathfinder ProXR series, Pathfinder Pocket, GPScorrect
and TerraSync are registered trademarks of:

TrimbleCorporate Headquarters

645 North Mary Avenue Sunnyvale, CA 94086

Windows NT, 2000, XP, Windows CE, Windows for Pocket PC and ActiveSync are registered trademarks of:
Microsoft Corporation

DNR Garmin is a registered trademark of:
Minnesota Department of Natural Resources
Garmin Communications using pcoGarmin by Ron Whately (http://www.c-nav.com)

Corpscon is provided by:
U.S. Army Corps of Engineers
Topographic Engineering Center, Alexandria, Virginia.

GPS-Photo Link are registered trademarks of
GeoSpatial Experts
12000 N. Washington, #385, Thornton, CO 80241

GPS Utility is registered to:

GPS Utility Limited

GPS Utility Limited, 30 Cadland Court, Ocean Village,
SOUTHAMTON, SO14 3GP, ENGLAND

Waypoint+ is registered to:
B. Hildebrand

CompassCom, Inc.
6770 S. Dawson Circle, Unit 1A. Centennial, Colorado 80112
303-680-3221 Fax 303-766-2488
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B. Base Station Map

The base station map can be found on the server at the following address.

http://fsweb.sanjuan.r2.fs.fed.us/gis/base_stations.pdf

C. Trimble Software Versions and Compatability

1. Determine Trimble’s current software/firmware versions

http://trl.trimble.com/docushare/dsweb/Get/Document-27877/SprtNote_ MGIS_CurrentSoftwareVersions.pdf

2. Trimble Products Compatibility -- Identify what is and is not compatible between the various

Trimble products.

http://trl.trimble.com/docushare/dsweb/Get/Document-160913/SprtNote PFOffice_Compatibility.pdf

D. Comparing Windows CE Operating Systems

The comparison between Windows CE.NET and Windows Mobile is similar to the comparison between Windows
2000 and Windows XP. Many applications that ran on earlier versions of Mobile or CE.NET may no longer run on
Mobile 2005. The design of the CE operating systems is also similar in look and feel to their PC counterparts.

Windows Mobile 2005
OS revision 5.1.12

B Geo4548428332 =3

File Zoom Tools Help
ie |5tart ok 4t 226
€ Thursday, Mai

vice unlocked

Calendar

Today Screen

€, Today

& ArcPad 6.0.3°
[ Calendar

FE Contacks

& Internet Explorer ol
& Messaqging £ status
G windows Media

PowerPoink Mohile o pep
F3 Excel Mobile

= GPS Controller

4 Word Mobile

| riotes

ffg Frograms

I Settings
2 Help

Today Screen — Start Menu
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Microsoft Activesync 4.1 or
later is required.
Connection to a Windows 2000
PC may be difficult.
Applications compatible
o ArcPad 7
o GPScorrect 2
Applications not compatible
o ArcPad 6.0.3 or earlier
o GPScorrect 1.11
o I-Mobile Apps version
1.1
o Activesync versions
prior to 4.1
Trimble GPS firmware is
bundled with the OS.



Windows Mobile 2003
OS revision 3.00.01

#RGeod538E00028 I - (O[]

File Zoom Tools Help

Friday, March 10, 2006
Tap here to set owner informal

Mo upcoming appointments
No unread messages
No tasks

i3 Geo1538E00028
File Zoom Tools Help

About Backlight

¢

ClearType Clock
Tuner

&

Power Regional
Settings

B &

Screen System
Information

Certificates

L

Memory

Remove
Programs

a

System
Report -

Perm1d|5ystm|Cm'rﬂctiu'rs|

New @3 |-
Today Screen Settings Screen
(Start = Settings = System tab)
Windows CE.NET
OS revision 2.00.02

M GeoCE4413A4
File Zoom Tools

#| BerAHD B

Main Screen

e  Similar to Windows 2000.

3l GeoCE4413A.
File Zoom Tools Help

File e
‘~..‘r -
Internet Keyboard
Ciptions
Crvnier Password
Porwar Reqional
Settings
I Wi
] i
Stylus System

E
Metwork anc—]
Dial-up Co...

PC
Connection

°

Remove
Prograrns

¥ &

Touch
Button o,

2z | 3
P TR

Control Panel

(Start > Settings = Control Panel)

®  Start menu typically occurs at the bottom of the screen.
® PC connection options accessed through Control Panel.
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Similar to Windows XP.
Start menu typically occurs
at the top of the screen.
Creating a connection to the
PC differs from CE.NET.
PC connection options
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E. Differential Correction in Pathfinder Office — (Classic)

N =

e

7.

Select Utilities = Other -> Differential Correction Classic.
Recently downloaded files will be visible in the window. If the desired files are not, select
the files to be corrected by clicking on Browse, navigate to the proper location, highlight and
click Open.
After selecting the Rover files to be corrected in the Differential Correction window, click
Internet Search to bring up Internet Search window.
If the desired Base Data Provider is available from the pull down menu, select the provider
and click OK. Skip to 7. (For San Juan Public Lands users, refer to the Base Station
Map in Appendix B.) Base files are good to within 500 kilometers (310 miles).
If the desired base station is not visible in the window, click New.
Selecting a provider
a. If you have never copied the provider list from Trimble:
1. Select copy most up-to-date list and click OK.
2. Click Yes.
3. Select provider and click OK.
b. If you have current provider list:
1. Select from current list and click OK.
2. Select provider and click OK.

NOTE: In choosing a provider, select a provider that has a high Integrity Index value (i.e.80
or above) that is within your coverage area. If several stations are above 80, choose the one
closer to your area.

Select a Base Provider -
Prowider | Location | Distance | Integrity Index | Al
0 rtac Mk Artec Mk 94 km 48.33 —
CORS, Alternate Master Clock {iming test) CO - Colarado Springs CO 276 km 86.90
CORS, Pueblo 1. CO Fueblo CO 260 km 86.62
Mesa County GPS/Surveying, MCO1 Grand Junction CO 242 km 86.22
CORS, Sandia ASLMMZ004 Albuguergue N 263 km 85.95
Mesa County GPS/Surveying, MCOZ Grand Junction CO 233 km 8b12
CORS, Fietown YLBA Site, NM Fie Town N 344 ki 34.66
CORS, Flatteville CO Flatteville CO 379 km 5455
CORS, Roswell Faoswell MM 483 km 8452
CORS, Tucumcar Nk Tucumcan M 390 km 84.48
CORS, Sarta Fe. MM Santa Fe Nk 200 krn 84.26
CORS, Carbon County Courthouse UT Price UT 421 km 84.23
SOPAC, Castle, daily Cleveland UT 386 km 8419
CORS. Summerfield 1 T Summerfield Tx 487 km 8416
Carbon County Frice UT 421 km 8410 =

Select Properties to enter the Provider Properties window.
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8.

9.

10.
1.
12.
13.

Provider Properties N -]

General Base Station InternetSer\:erISecurityI

Receiver type rirnkle 5700

Base station type ITrlmb|E

Cither Infarmation: & second logging rate

— Reference Position (WGES 84)

" Use reference position from base file
& Always use the following position:

Latitude |35 40 25 64426 M

Longitude: I]DS E7 3096723 W

Altitude (m HAE): IEDSE.BDE

[ ok | cencer | s | Help |
example of Santa Fe CORS

Select the Base Station tab and select Always use the following position if not already
selected. Click OK.
NOTE: It is recommended that this value be periodically reviewed with against the published
coordinates on the Internet.
Click OK. The program begins downloading base files to the directory you have set up for
the project.

Click OK. Do not adjust the Reference Position unless it differs from the website.

Click OK. The files will now be visible in the base file window.

Click OK to start correcting the Rover files.

Click Close to finish. You may need to review the Log file if there were problems.

F. CORPSCON

Corpscon is a free coordinate convertor program developed by the military. It can transform coordinates
between Lat/Long and UTM as well as NAD27, NADS83 and State Plane. There is also a conversion for
Decimal Degrees to Degrees Minutes Seconds. This program can convert single points or coordinates in
a textfile. The program is available at the following address:

http://crunch.tec.army.mil/software/corpscon/corpscon.html

1. Converting Coordinates in a Texfile

a.

Textfile format
For Corpscon to operate correctly, it is important to have the textfile in the correct format.
1. Projected Coordinates

If using projected coordinates (i.e. UTM, NAD27), an example of a simple format that

can be created in Notepad, WordPad or any text editor that can save in comma-delimited
format (.csv, .txt) is as follows:
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374300, 4120556, sign
321200, 4123800, monument
end

Notice end at the bottom of the file. This is required if all values are to be read. A header
row (East, North, Comment) may be added, but it will not be carried over into the output
file Corpscon creates. The textfile can be made more detailed if desired. Corpscon can
handle up to six (6) fields in the textfile.

2. Geographic Coordinates

Corpscon can convert three formats: DD.dddd, DD-MM.dddd and DD-MM-SS.dddd.
The following textfile format is an example:

107 00 15.88, 37 05 16.23, shack
107 14 29.90, 37 22 12.932, mine shaft
end

OR
107.22345, 37.889223, plot 3442
107.23322, 37.449993, plot 3443
end

Notice end at the bottom of the file. This is required if all values are to be read. A header
row (Long, Lat, Comment) may be added, but it will not be carried over into the output
file Corpscon creates. The textfile can be made more detailed if desired. Corpscon can
handle up to six (6) fields in the textfile. NOTE: In contrast to ArcMap, there is no
negative value (-) for Longitude. Corpscon cannot use negative Longitude values.

b. Converting a Textfile

NOTE: The following directions will use the example of converting a file with Lat/Long
coordinates in NAD27 Degrees-Minutes-Seconds into a file containing NAD27 Decimal
Degrees. The basic process of converting a textfile into other types of coordinates is the
same.

1.

SNk W

In Corpscon, select Send Data - To Output File. A checkmark will be added. This will
turn the Output File option ON in the Send Data window.
Select the Input Format. Input Format - Geographic Coordinates NAD27...
Select the Output Format. Qutput Format - Geographic Coordinates NADS3...
Select Convert > User Defined Input File.
Input File
i. In the Field Specifications box:

a. Field 1, select Longitude.

b. Field 2, select Latitude.

c. Field 3, select Point Name.
ii. In the Other box:

a. Delimeter, select Comma.

b. Degree Format, select Degrees-Minutes-Decimal Seconds.
iii. Browse for the Input File containing the coordinates to convert. Click OK.
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6. Output File
i. In the Field Specifications box:
a. Field 1, select Longitude.
b. Field 2, select Latitude.
c. Field 3, select Point Name.
ii. In the Other box:
a. Delimeter, select Comma.
b. Degree Format, select Decimal Degrees.
iii. Name the new Output File and select a destination. Click OK.
7. A Status window will appear showing if the conversion was successful.
8. Check the output file to make sure all values were converted and that the values are what
they are supposed to be. In this example, the values would be in Lat/Long NADS83
Decimal Degrees.

G. GeoCE series (TSIP Protocol)
1. Start ArcPad.

2. Open the ArcPad Options i
3. Protocol Tab
a. Protocol - TSIP
b. GPS > WGS84 (Do not change this!)
c. Height is optional.
4. GPS Tab
a. Port > COM3
b. Baud = 9600
c. Parity > Odd

H. Commands
1. Windows commands

copy -- copy file(s) to a destination.
del -- deletes file(s).

dir  -- lists the contents of a directory.
move -- moves file(s) to a different location.
ren -- rename file(s)

cd -- change directory.

md  -- creates a directory.

rd -- removes a directory.

2. UNIX commands

I —list long (lists files in a directory including date and file size.)
Is  —list short (lists files in a directory, name only.)
pwd - lists current directory.
cd - changes directories.
3. ARC commands
lc - list cover (lists coverages in a workspace.)

kill - removes coverages from workspace.
copy — copies coverages from one location to another.
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cw -- creates a workspace.

q -- quits ArcInfo

<> -- items in < > define the names of files/folder or options the user needs to use in
association with ARC commands.

I. Arclnfo for PC/Unix
1. Making Pathfinder Export Files into a Coverage

a. Open a command line Arc prompt.

b. At the command prompt, navigate to the path (directory structure) where the exported GPS
files are to be located.

c. At the command prompt in the AIX window, type arc to run ArcInfo.

d. For working with files and coverages, a workspace will need to be created at the ARC prompt
if one does not exist already. A workspace is a directory that contains coverages, an INFO
subdirectory and other related ARC files. Additional directories or workspaces can be added
underneath the original workspace.

Arc: cw <workspace>
(i.e. Arc: cw gps_data)

e. Move or copy files from the PC to the desired workspace using Windows Explorer. Check to
make sure filenames are in lower case letters.
f. Before creating covers, the AML file for each feature must be modified:
1. Open Windows Explorer and find the AML for the feature located in the workspace
on the server.
2. Right mouse click 2 Open With - select WordPad.
3. edit AML file to include the path (location) of the attribute file after ADD
FROM. For area amls, the clean tolerances need to be changed from
# to 0.00000001. (see sample Area AML)
(i.e. ADDFROM /fsfiles/office/so/recreation/gps_data/camps.aml)
4. Click Save and Close.
5. Edit .pts file for area covers (polygons) if needed to correct mislocated label points.
The label point is based on the centroid of the entire feature and that point may lie
outside of the area. Labels outside of the area will result in the attributes not being
appended to the polygon attribute table. In other words, certain polygons will lack
attributes. To correct: pick any coordinate that is within the area and change the bad
coordinate in the .pts file using the corresponding ID number as a reference.
(i.e.1,456211.002, 4865222.921. The 1 is the ID.) Save and Close file.
6. Repeat the process for each feature.
g. Run the corrected AML at the ARC prompt to create cover.

Arc: &r <aml file>
(i.e. Arc: &r camps.aml)

h. Rename the coverage. Use l¢ to list available coverages if needed.

Arc: rename <old_cover> <new_cover>
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(i.e. Arc: rename camps fs_camps)

NOTE: Coverage names should not start with a number, be no longer than 13 characters and do
not have spaces within the name.

i. Overlapping Polygons
If overlap polygons occur, a new polygon is created void of attributes and labelpoints.
This will make it necessary to either:
1. edit polygons in Pathfinder Office so no overlaps occur.
or
2. add new fields to the attribute table, re-enter the missing attributes and create
labelpoints for the new polygons.
NOTE: For the addition of new fields and labelpoints, consult your GIS specialist. It may be
necessary to use regions if overlaps are present.

j. If necessary, combine multiple covers of like features into one coverage by using the append
command (or consult your GIS specialist). This command requires that the covers being
merged have identical attribute fields. If they don't, these fields must be edited or append will
not work.

Arc: append <out_cover> <point | line | poly>

k. If errors occur at any time during METHOD I (Arc bailing out of the AML for example), it
will be necessary to kill the attempted coverage. This command is also used for removing
older covers.

Arc: kill <cover> all

1. Sometimes corrupted covers and/or files cannot be removed with kill or delete. To remove
these, quit Arc and use the following:

:rm -R <file>

m. Proceed to further fine-tune and edit the new coverage within ArcInfo software (Arcedit,
ArcTools, ArcMap). This procedure may need to be done by a GIS specialist.

Tech Tip #A.1 Never drag and drop coverages. Always copy a coverage when moving it to a different

destination by using the copy command in Arc or by copying it in ArcCatalog.

#A.2 Areas can have labelpoints occur outside of their perimeter that can cause attributes to

be dropped when generating a coverage. In ArcInfo, overlapping Areas will create new
polygons without attributes and labelpoints.

#A.3 Labelpoints are necessary for Areas if attributes are to be appended from the attribute
table.

#A.4 Lines and Areas need editing to remove spikes and squiggles as much as possible before
they are made into coverages.

#A.5 Depending on the types of Line features (roads, streams, etc.), they will need to be
snapped (connected) together to form continuous data.

#A.6 Length, perimeter and area values may differ in GIS vs. the original (edited) GPS

corrected file. Any editing done in GIS will alter the values further.
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#A.7 Arc may not allow the use of comma-delimited files with uppercase file extensions.

#A.8 A file containing only a single point feature cannot be made into a coverage. There must
be two or more point features in one file.

#A.9 Comma-delimited files sometimes have hidden carriage returns within the file that must
be removed using the VI editor in UNIX for use in AML’s.

2. Converting XY Data in a Textfile to a Coverage

The only reason to use this export type is if substantial editing to the attribute table is needed.
Even so, the ArcInfo format can also accommodate this need as the .aa, .pa and .gen files are
essentially comma-delimited (.csv) which can be opened in most spreadsheets. Covers can also
be generated from ASCII files that were produced in a spreadsheet providing the files are saved
in comma-delimited format.

a.
b.

a.

Copy or move files into workspace.

Using the sample AML as a guide, insert the proper names for the files requested. When
defining the attribute file, enter the field names that correspond with the data's attributes. DO
NOT use the fields listed in the samples as a default. They are only intended to be used as a
guide. Save the file when through editing the AML.

Files created or saved in .csv format (not the .aa or .pa) contain carriage returns that must be
removed before the AML is run. Edit the files using VI editor in Unix.

> vi <filename>
:g/[centrl]v[centrlm/s///
:w(q (this saves the file and exists VI editor)

END (uppercase letters) must be added at the end of coordinate files. (In an arc or poly file,
there will actually be two END’s at the bottom of the file.) Save files when finished and
Close.

Run AML

Arc: &r <aml file>

Converting a Shapefile to a Coverage

Ensure the Arc environment is set to precision double double, if needed type this on the

command line. Anything else will incur arc or polygon movement within the coverage.
SINGLE precision covers have a larger tolerance default value than DOUBLE. This
gives arcs and polys greater freedom to move around creating potential accuracy problems.

. Convert shapefile into a coverage.

Arc: shapearc <shapefile> <cover> <subclass>
(i.e. Arc: shapearc camps.shp fs_camps poly)

NOTE: Subclass should be used if converting area data into a polygon coverage. This will
create regions containing the area attribute data. If no subclass is used, the attributes will be
attached to the arcs, not the polygons.

. Redefine tolerances of the new coverage.
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Arc: tolerance <cover> <type> <value>

The <type> is the tolerance to define and <value> is the value of the tolerance.
The following is a list of suggested values. Depending on the data, it may be necessary to
adjust these values.

Type
weed

grain
node
snap

Value
0

1
1
1

d. The cover will then need to be cleaned to remove intersect errors involving line and area
coverages. Polygon features are converted into Regions so overlapping polys are allowed.

Arc: clean <old_cover> <new_cover> 0.0000001 0.0000001 {linelpoly}
(i.e. Arc: clean fs_camps fs_camps2 0.0000001 0.0000001 poly)

Use regionpoly if polygon topology is needed. This converts regions into a separate polygon
coverage.

Arc: regionpoly <in_cover> <out_cover> <in_subclass> <out_table>
(i.e. Arc: regionpoly fs_camps2 fs_camps3 poly polytable)

e. Kill unnecessary covers using:

Arc: kill <cover> all

f. Rename coverages as needed.

Arc: rename <old_cover> <new_cover>

J. NAD27/NADCON GPS-GIS Operations and References

USGS Topo

Polyconic NAD27, 1000m grid tics UTM NAD27 with corner tics generally using Geographic
(Lat/Long) NAD27.

GPS receivers

when collecting data, most GPS units store positions in Geographic (Lat/Long) WGS84

Waypoints

when creating waypoints, one must keep in mind what projection/datum the source coordinates are
in, especially when entering the coordinates by hand. Geographic WGS84/NADS83 coordinates are
different from Geographic NAD27 coordinates.

NADCON

NADCON is the Federally accepted transformation method from NADS3 to NAD27. In GPS,
when desiring NAD27 coordinates, set the datum to NADCON. In GIS, when converting between
WGS84/NAD83, use NADCON as the transformation. Results can vary by several meters if
NADCON is not used.

ArcMap

In a NAD27 dataframe, the default transformation in ArcMap does not Project-on-the-Fly WGS84
correctly. Refer to Appendix J, part 3 for a method of projecting WGS84 to NAD27 to within a
meter in the dataframe and projecting to NAD27 using Toolbox.

ArcPad

ArcPad is using equation based and not grid based transformation methods. Its problem is similar to
ArcMap’s in respect to WGS84.

The following is an example of coordinate values and how they can differ. The GIS point at
37°15” 00”N 107° 00’ 00”W is the Southeast corner tic of the Pagosa Springs Quadrangle.
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*The correct location when displayed with GIS data in NAD27 is that generated through NADCON.

Geographic WGS84 | Geographic NAD27 | *Geographic UTM NADS83 UTM NAD27 *UTM

(GPS) Conus (GIS NAD27) Conus Conus (GIS NAD27)
NADCON NADCON

37°15°00.020401”N | 37°14°59.94772”N | 37°15’°00"N 322569.740E 322619.757E 322618.096E

107°00°02.13974”W | 106°59°59.93118”W | 107°00°00"W 4124482.331IN 4124275.163N 4124276.810N

1. NAD27 on the Trimble GPS Unit
A wide variety of coordinate systems and datums are available for use. The user should set
this in accordance to the needs of the project. This affects display only. NOTE: NADCON
Conus is available as a datum. If desiring a reading in NAD27, it is best to use NADCON
Conus as the selection and not NAD27. This applies to both UTM and Lat/Long readings.

2. NAD27 in Pathfinder Office
Coordinate System
Check Use Export Properties and click Change.

System: UTM

Zone: 13 North

Datum: NADCON (Conus)
Units: Meters

NOTE: NADCON (Conus) should be used when converting GPS (WGS84/NADS83) data to the
NAD27 datum. DO NOT use the NAD27 (Conus) setting as it does not use the correct
transformation algorithm.

3. ArcPad 6 - “The Datum Transformation Shift” — WGS84 versus NAD27
Issue: GPS data shifts 12-15 meters from the correct location when using the NAD27 datum.

Basically, this is the same issue that ArcMap has with Project-on-the-fly WGS84 to a NAD27
datum. ArcPad only supports equation-based, and not grid-based (i.e. NADCON), datum
transformation methods. This means incoming WGS84 GPS coordinates are being transformed
into NAD27 using a different method than how the original data was transformed.

In addition, the NAD27 datum has close to 20 different transformation methods to choose from
for North America (i.e. Alaska, Western US, Caribbean, etc.). Theoretically, the correct datum
transformation needs to be used depending on the part of the country you’re in. The first time the
NAD?27 projection is set in ArcPad, the default transformation for WGS84 to NAD27 is #1530
(top of list). This is the reason for the shift in GPS location. Do not use #1530!

Solution:
One of two datum methods must be set within the Layer Properties using the datum

transformation option B At this time, the recommendations for Region 2 are:

If using GPScorrect with ArcPad
8075 (-3, 159, 175) /* Mean for Western US (CONUS West of Mississippi River) (PE_GT_NAD_1927_TO_WGS_1984_6)
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If using Stand-alone ArcPad, real-time uncorrected GPS data

8074 (-9, 161, 179) /* Mean for Eastern US (CONUS East of Miss. River including MN, MO, and LA)
(PE_GT_NAD_1927_TO_WGS_1984_5)

%M Datumns _ZI

Narne [ [Tra. |Metwod [ spherod | a |17 ox oy Dz R¥X | RY

D_Morth.. 6267 1530 | Geocentri.. Clarke_1.. |6378206.4 | 204.09786.. -4 135 181 0 0

D_Morth.. 6267 8070 | Geocentri.. Clarke_l.. |6378206.4 | 204.09786.. | -3 M2 183 0 0

D_Morth.. 6267 8071 | Geocentrl.. Clarke_L.. |6378206.4 | 204.59786.. O 25 |14 0 0

D_Morth.. 6267 8072 | Georentri.. Clarke_L.. 63782064 |294.9786.. |-10 158 187 |0 i

&l Layers D_Morth.. 6267 8073 | Geocentri.. Clarke_l.. |6378206.4 | 204.9786.. -8 10 176 0 0
= D_Morth.. 6267 8074 | Geocentri.. Clarke_1.. |6378206.4 | 204.9786.. |9 w1 179 0 0
@l Title | ﬂl g I e oD porth.. 6267 9075 Geocentri.. Clarke_1.. 63782064 204.9786.. 8 158 175 0 o
D_Morth.. 6267 8076 | Geocentri.. Clarke_L.. |6378206.4 |204.0786.. |5 135 (172 |0 0

[T 2°GPS Tracking ) D_Morth... 6267 | 8077 | Georentri.. Clarke_l.. 63782064 |204.0786.. -4 154 178 0 0
I EMap Grid D_Morth.. 6267 8078 | Geocentri.. Clarke_l.. |6378206.4 | 204.9786.. |1 40 165 0 0
~  Ebirdibdy.shy BT Je, D_orth.. €267 €072 | Geocenti.. Clarke l.. 63782064 | 204.9786... | 7 w2 |18 0 0
D_Morth.. 6267 8080 | Geocentrl.. Clarke_L.. |6378206.4 | 204.9786.. 9 157 |14 0 0

D_Morth.. 6267 8081 | Geocentri.. Clarke_1.. 63782064 |294.09786.. |22 160 190 |0 i

D_Morth.. 6267 8082 | Geocentri.. Clarke_l.. |6378206.4 | 204.9786.. 4 158 (1 0 0

D_Morth. 6267 8083 | Geocentri.. Clarke_1.. |6378206.4 | 204.9786.. | -7 138 181 0 0

D_Morth.. 6267 8084 | Geocentri.. Clarke_l.. |6378206.4 | 294.9786.. O 25 201 o 0

D_Morth.. 6267 8085 | Geocentrl.. Clarke_l.. |6378206.4 | 204.0786.. -0 152 (172 0 0

D_Morth.. 6267 8086 | Geocentri.. Clarke_l.. |6378206.4 | 294.9786.. 11 14 (195 0 0

D_Morth.. 6267 8087 | Geocentri.. Clarke 1. | 63782064 | 294.9786.. -12 130 190 |0 0

D_Morth.. 6267 8152 | Geocentri.. Clarke_l.. |6378206.4 | 204.09786.. 2 152 149 0 0

D_Morth.. 6267 8153 | Geocentrl.. Clarke_L.. |6378206.4 | 204.9786.. |2 04 105 |0 0

Another thing that can be done is modify or replace the apDatums.dbf by moving #8074 or
#8075 to the top of the D_North_American_1927 list. This file is located in \System directory of
the ArcPad installation. On the GeoCE unit, this is \Disk\ESRI ArcPad 6.0\System.

Tech Tip #A.10 Do not use #8074 with GPScorrect. Upon post-processing, the corrected data will be
placed too far south.

4. Project-on-the-Fly WGS84 Data to NAD27 in ArcMap

a. In ArcMap, set the projection of the dataframe to UTM NAD27.
1. This can be done in an empty dataframe by adding a layer containing a NAD27
projection file to the dataframe.
2. Or, set the dataframe projection by right-clicking on the dataframe name (Layers) =
Properties and select the NAD27 projection from the Predefined folder.
b. The Current Coordinate System window should now have a NAD27 projection listed. Click
OK to close the properties.
c. Add a WGS84 projected layer to the dataframe. If a question box pops up, click OK.
d. Access the dataframe properties again and select Transformations...
e. In the using: dropdown, select NAD_1927_To_WGS_1984_6 as shown in the following
diagram. This will bring the layer to within approximately one meter of the true location.
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Geographic Coordinate System Tran_EIZI

Conwvert from:
oK. |
Cancel |

GCS Arr

erican_1927
51584

into:
|GCS_Morth_american_1927 =

using:
INAD_1 927_To_WGS_1984_6 j Mew...

Method:  Geocentric Translation

f. Click OK.
g. Click OK to close the dataframe properties.

. Correcting WGS84-NAD27 Shifted Data Collected in ArcPad

NOTE #1: This process corrects NAD27 data collected in ArcPad using the #1530 (default)
datum transformation.

NOTE #2: As a result of revisions to the apDatums.dbf file, there are at least two (2) versions of
#1530. The procedure below used one of the versions of the datum transformation.
Refer to the apDatums.dbf file for the exact transformation numbers used and adjust
the following procedure accordingly.

If you have ArcPad GPS data in NAD27 collected with the #1530 datum transformation, this
data can be fixed by reprojecting it back into WGS84 and then reprojecting again into the proper
NAD?27 datum of your choice. The solution is to use a custom datum transformation.

Now, in order to do this you need to know that when using 1530, ArcPad data going from
WGS84 - NAD27 is transformed using the following numbers:

Transform X (m) 4

Transform Y (m) -135

Transform Z (m)-181
This matches the apDatums.dbf file in ArcPad.

In order for this shifted data to go from NAD27 - WGS84, you will need to reproject using the
following numbers:

Transform X (m) -4

Transform Y (m) 135

Transform Z (m) 181
Positive and Negative numbers are reversed depending on which direction you go.

a. In ArcMap (version 9.0), add the data needing corrected to ArcMap.

b. Set the dataframe coordinate system to Geographic WGS 1984 (GCS_WGS_1984).
Right-click on the dataframe and select Properties.

c. Select the Coordinate System tab

d. In Select a coordinate system window, select Predefined > Geographic Coordinate
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Geographic Coordinate System Transfor

System = World 2> WGS 1984
e. Click Transformations.

f. At the geographic transformations(s) screen, click New.

2| x]

0K |

Canvert fram

GICE_Marth_American_1927

GCS_Marth_American_1983

GC5_WGS5_1984 Fo— |
Into:

[ GCS_wGs_1954 |

Using:

[Mew 1530 = New |
Method:  Geocentric Translation - dx=-4.000000 cy=135.000000 dz=181.000000

New Geographic Transformation N 1]

Marne INeW153D
Source GCS |GCE_Nm{h_Amencan_T 927
TargetGOS: GO wGs_1984 |
Method
MName IGeocemncTrans\amn j
Parameters MName | Value I
* Axis Translation (meters) | -4
Y Axis Translation (meters) | 135
Z Axis Translation (meters) | 181

o]

Cancel |

g. Enter the values of —4, 135, 181 for X, Y, Z. A new name is optional. Click OK.

h. Click OK. Click OK.

i. Right-click on the layer and select Data - Export Data.
j. Select Use the same Coordinate System as the data frame.
k. Name the file and click OK. The file has been correctly projected back into WGS84.

K. Web Links

1.

Definitions
Datum definitions
http://arcsdeonline.esri.com/capi_functions/include files/pedef.htm

http://biology.usgs.gov/geotech/documents/datum.html

Software
Corpscon software download page
http://crunch.tec.army.mil/software/corpscon/corpscon.html

ESRI Arcscripts website
http://arcscripts.esri.com/

Trimble Planning Software and Ephemeris/Almanac download
http://www.trimble.com/planningsoftware_ts.asp?Nav=Collection-8425

DNR Garmin software page
http://www.dnr.state.mn.us/mis/gis/tools/Arcview/extensions/DNRGarmin/DNR Garmin.html

GPS Utility software page
http://www.gpsu.co.uk/

Waypoint Plus software page
http://www.tapr.org/~kh2z/Waypoint/
GPS-Photo Link

http://geospatialexperts.com

GPS/GIS sites
San Juan NF GIS/GPS intranet page
http://fsweb.sanjuan.r2.fs.fed.us/gis.shtml

US Forest Service National GPS website
http://www.fs.fed.us/database/gps/

Santa Fe NF GPS intranet page
http://fsweb.santafe.r3.fs.fed.us/gis/sfnf

s basefile.html

CompassCom homepage
http://www.compasscom.com/
ESRI hompage

http://www.esri.com/
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Trimble homepage
http://www.trimble.com/

Mesa County, Colorado GPS website
http://www.co.mesa.co.us/GPS Survey/GPS_Survey.htm#To,

Garmin homepage

http://www.garmin.com/

Federal Aviation Administration GPS website
http://gps.faa.gov

National Geodetic Survey homepage
http://www.ngs.noaa.gov/CORS/cors-data.html

4. PDR and Evaluation information
Rangeland Management Service Center
http://fsweb.ftcol.wo.fs.fed.us/frs/rangelands/pdr/index.shtml
NRIS software
http://sandy1.sandy.wo.fs.fed.us/terra_docs/articles/pdr-2.htm
Mobile computing (PDR) evaluations
http://fsweb.sdtdc.wo.fs.fed.us/programs/im/fy03/ppc/ppe.shtml
What’s New, including GPS receiver evaluations, at the US Forest Service National GPS website
http://www.fs.fed.us/database/gps/gpsusfs.htm

L. Document Revisions
7.0 revisions from 6.1
Removed documentation pertaining to ArcView 3.x
Added Disclaimer
Added section on GPS Photo-Link
Added section on GPS Analyst
Added section on Metadata
Added comparison of GeoCE models and CE operating systems
Removed GPSi documentation
Added more detail on real-time differential correction
Added Coordinate Tool bar
10. Added custom Garmin maps documentation
11. Revised ArcPad section
12. Revised Differential Correction process within Pathfinder Office
13. Moved CORPSCON to Appendix
14. Added sources of GPS error
15. Added file extensions description
16. Added part on adding DMS data
17. Added GPS from a GIS perspective
18. Added GPS Controller settings
19. Added WGS84/NADS83 datum transformation scenario settings
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